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Copyright and Safety Notification 
This manual contains notices that you should observe to ensure your own personal safety, as well as to 
protect the product and connected equipment. These notices are highlighted in the manual by a warning 
triangle and are marked as follows according to the level of danger: 

 

Danger 
Indicates an imminently hazardous situation that, if not avoided, will result in death or serious injury. 

 

Warning 
Indicates a potentially hazardous situation that, if not avoided, could result in death or severe injury. 

 

Caution 
Used with the safety alert symbol indicates a potentially hazardous situation that, if not avoided, may result in 
minor or moderate injury. 

 Caution 
Used without the safety alert symbol indicates a potentially hazardous situation that, if not avoided, may result 
in property damage. 

 Notice 
NOTICE used without the safety alert symbol indicates a potential situation that, if not avoided, may result in an 
undesirable result or state. 

Qualified Personnel 
The device/system may only be set up and operated in conjunction with this manual. Only qualified 
personnel should be allowed to install and work on this equipment. Qualified persons are defined as persons 
who are authorized to commission, to ground, and to tag circuits, equipment, and systems in accordance 
with established safety practices and standards. 

Correct Usage 
Note the following: 

 

Caution 
This device and its components may only be used for the applications described in the catalog or 
the technical descriptions and only in connection with devices or components from other 
manufacturers that have been approved or recommended by Siemens. 

This product can only function correctly and safely if it is transported, stored, set up, and installed 
correctly, and operated and maintained as recommended. 

Trademarks 
Siemens®, SIMATIC®, HMI®, MP370®, and ProTool® are registered trademarks of SIEMENS AG.  
WinAC MP™ is a trademark of SIEMENS AG. ActiveX® and Windows® are trademarks of Microsoft
Corporation. 

Other designations used in this document are also registered trademarks; the owner’s rights may be 
be violated if they are used by third parties for their own purposes. 
Copyright Siemens Energy & Automation, Inc., 2003 
All Rights Reserved 
The reproduction, transmission or use of this document or 
its contents is not permitted without express written 
authority. Offenders will be liable for damages. All rights, 
including rights created by patent grant or registration of a 
utility model or design, are reserved. 

Disclaimer of Liability 

We have checked the contents of this manual for agreement 
with the hardware and software described. Since deviations 
cannot be precluded entirely, we cannot guarantee full 
agreement. However, the data in this manual are reviewed 
regularly and any necessary corrections included in 
subsequent editions. Suggestions for improvement are 
welcomed. 

Siemens Energy & Automation,PCbA 
755 College Road East 
Princeton, NJ 08540, USA 

© Siemens Energy & Automation, Inc., 2003 
Technical data subject to change. 
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Preface 
WinAC MP is a software S7 PLC for the SIMATIC MP370 12” keyboard multi panel and the 
MP370 Touch 12” and 15” multi panels that you can use to control a network of PROFIBUS-DP 
devices. ProTool works with WinAC MP to provide process visualization and control. 

WinAC MP consists of the following elements: 

y WinAC MP controller software for the MP370 and MP370 12” and 15” Touch multi panels 

y STEP 7 project for WinAC MP 

y ProTool projects for MP370 and MP370 12” and 15” Touch multi panels with WinAC MP 
example screens, and add-in WinAC MP components for ProTool CS 

y SIMATIC WinAC MP for MP370 User Manual (electronic) 

y Authorization diskette 

y Software Product Sheet 

Audience 
This manual is intended for engineers, programmers, and maintenance personnel who have a 
general knowledge of SIMATIC programmable logic controllers. Knowledge of STEP 7 
programming, ProTool, and WinAC is also required. 

Scope of the Manual 
This manual describes the features and the operation of version 3.1 of WinAC MP. 

How to Use This Manual 
This manual provides the following information: 

y Product Overview 

y Transferring WinAC MP to the Multi Panel 

y Developing and Downloading a STEP 7 Project for WinAC MP 

y Controlling Your Process with WinAC MP 

y Customizing WinAC MP for Your Application 

y Reference Information 

Other Manuals 
For additional information, refer to the following manuals: 
 

Related Manuals 

Title Content 
STEP 7 User Manual Provides information on programming in STEP 7. 
ProTool User Manuals Provide basic information about the configuration of ProTool user 

interface screens and ProTool on the multi panel. 
SIMATIC NET User Manual Provides information on communication and networking with 

SIMATIC NET. 
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Contacting Customer Support 
You can find additional information about WinAC MP and updates to this user manual at the 
Siemens Energy & Automation web site: 

www.sea.siemens.com/software 

This web site includes useful information, such as application notes, in the Technical Service 
area. 
 

Customer Support 
North America 
Telephone (423) 262-2522  
E-mail simatic.hotline@sea.siemens.com 
Internet http://www.sea.siemens.com 
Europe 
Telephone ++49 (0) 180 5050 222 
E-Mail support@siemens.com 
Internet http://www.ad.siemens.de/support 
Fax ++49 (0) 180 5050 223 
Asia  
Telephone ++86 1064 757575 
E-Mail adsupport.asia@siemens.com 
Internet http://www.ad.siemens.de/meta/karten/html_76/welt.htm 
Fax ++86 10 64 747474 
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Product Overview 
The WinAC MP controller on the multi panel can execute a STEP 7 control program that works 
with a network of PROFIBUS-DP devices to control your process. The multi panel can run a 
ProTool project that provides the user interface to the controller and process visualization. 

 
Figure:   Process Control with WinAC MP 

To use the multi panel for process control with WinAC MP, you must install software on a 
configuration computer (PC), and transfer components to the multi panel. 

System Requirements 
To install and use WinAC MP, you must have a configuration computer (PC) with one of the 
following operating systems: 

y Microsoft Windows 98 Second Edition 

y Microsoft Windows Millenium Edition  

y Microsoft Windows NT 4.0 Workstation with Service Pack 6a or higher 

y Microsoft Windows 2000 Professional with Service Pack 1 or higher 

y Microsoft Windows XP Professional, Service Pack 1 recommended 

This configuration computer must also have the following: 

y 10 Mbytes or more on the hard disk drive 

y 32 Mbytes or more work memory 

This configuration computer must have the following software installed, in the sequence shown: 

y STEP 7 V 5.2 or higher 

y ProTool CS V 6.0 SP2 or ProTool/Pro CS V 6.0 SP2 

You also need: 

y An MP370 or MP370 12” or 15” Touch multi panel with 5 MB free flash memory for user 
application 

y A standard cable connecting the Ethernet, serial, MPI, or USB ports of the configuration 
computer and the multi panel 

y SIMATIC NET if you plan to use Ethernet communication (SIMATIC NET CD 11/2002 for 
Windows XP, SIMATIC NET CD 7/2001 SP5 for all other platforms) 

y Any devices necessary for process control connected to your multi panel across a 
PROFIBUS-DP network 
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Installation and Transfer Tasks 
To use WinAC MP for process control, you must perform installation and development tasks on 
the configuration computer, and transfer the necessary components to the multi panel. You must 
perform these tasks: 

• Verify that your system meets the system requirements 

• Install WinAC MP on the configuration computer and multi panel 

o Install the WinAC MP software on your configuration computer using the WinAC MP 
installation CD. 

o Transfer the WinAC MP runtime files and authorization from the configuration 
computer to the multi panel using ProSave, as described in the chapter “Transferring 
WinAC MP to the Multi Panel” (p. 7) 

• Develop a STEP 7 project to control your process from WinAC MP on the multi panel, as 
described in the chapter “Developing and Downloading a STEP 7 Project for WinAC MP” 
(p.23) 

o Develop control program logic 

o Configure hardware including PROFIBUS-DP device network 

o Download the STEP 7 project to the multi panel 

Note 
The WinAC MP installation includes an example STEP 7 project, 
ZEn08_01_WinACMP_Panel. 

• Develop a ProTool CS project for the multi panel to be the user interface to WinAC MP and 
your procsss. You can choose from the following options: 

o Use an example ProTool project as provided with the WinAC MP installation 

o Customize an example ProTool project for your application 

o Create your own ProTool project for your application 

The STEP 7 example project for WinAC MP includes three ProTool CS projects, one each 
for the MP370 keyboard unit multi panel, the MP370 12” touch panel, and the MP370 15” 
touch panel. The chapter “Controlling Your Process with WinAC MP”  (p.33) describes how 
to use an example ProTool project for process control. 

For information on developing screens with ProTool CS, refer to the ProTool CS 
documentation. Also, the chapter “Customizing WinAC MP for Your Application”  (p. 45) 
provides information about using WinAC MP functions and controls with ProTool CS. 
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The following diagram illustrates the correlation between the configuration computer and the multi 
panel for the types of files you must transfer: 

 
Figure:   Overview of Transfers 

When you have downloaded all of the necessary files, the multi panel is ready for process control. 
The chapter “Controlling Your Process with WinAC MP” describes how to use WinAC MP with an 
example ProTool project. 
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Screens Provided by the ProTool Example Projects 
The example ProTool projects contain WinAC MP functions, ActiveX controls, and two screens 
with WinAC MP components for process control and monitoring.  

Both example screens contain function keys or touch buttons on the left for WinAC MP 
operations. The chapter “Controlling Your Process with WinAC MP” describes how to use the 
example screens. The chapter “Customizing WinAC MP for Your Application” lists the available 
WinAC MP functions and how to use them in ProTool CS to create your own process screens, or 
modify the example screens. 

The first example screen is the WinAC_MP_Panel screen:  

Figure:   WinAC_MP_Panel Screen 

The WinAC_MP_Panel screen uses a combination of ActiveX controls and screen objects with 
WinAC MP functions attached:  

y The WinAC MP ActiveX control provides a control panel that serves as your interface to 
the WinAC MP controller. The control panel provides everything you need to monitor and 
operate the WinAC MP controller: all the status indicators, plus mode buttons that allow 
you to change the operating mode of the WinAC MP controller.  

y The Cycle Time area and the Min Sleep Time field are screen objects with WinAC MP 
functionality. When the WinAC MP controller is running, you can watch the last cycle 
time, average cycle time, maximum cycle time, and minimum cycle time update in the 
Cycle Time area. The Cycle Time screen objects are read-only. You can set the minimum 
sleep time value (ms) in the Min Sleep Time field, which is a read/write field, to tune the 
scan cycle.  

y The Histogram ActiveX control provides visual information about cycle time (when the 
WinAC MP controller is running) in the form of a histogram.  
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The second example screen is the WinAC_MP_Function screen:  

Figure:   WinAC_MP_Function Screen 

This screen uses screen objects such as buttons and bitmaps, rather than the WinAC MP ActiveX 
control, to provide a control panel interface for the WinAC MP controller.  
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Compatibility 
WinAC MP V3.1 is compatible with WinAC Basis V4.0. STEP 7 programs developed for 
WinAC MP can be used without change in WinAC Basis and in S7-300/400 controllers. In the 
hardware configuration, however, note that WinAC Basis can support up to four submodules, but 
WinAC MP has only one. 

ProTool projects developed for WinAC MP 3.0 can be used without change in WinAC MP 3.1. 

What’s New? 
If you have previously used WinAC MP, these features have been added since the last release: 

• Support of the 15” version of the MP370 Touch panel 

• Improved handling of retentive data 

• WinAC MP functions for archive and restore 

• Configurable automatic start after power on 

• Peer-to-peer communication 

• Ability to reset the cycle time histogram data 

• Ability to get the WinAC MP version number 

• Fixed WinAC MP controller priority: always higher than ProTool on the multi panel; not 
tunable by user 

For more information on these features, see the related topics in the chapter “Controlling Your 
Process with WinAC MP” (p. 33) or in the summary of “WinAC MP Functions” (p.47). 
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Transferring WinAC MP to the Multi Panel 
To transfer WinAC MP from the configuration computer to the multi panel, you must perform 
tasks on both the configuration computer and on the multi panel. This chapter explains how to 
perform the following tasks: 

1. Set parameters on the configuration computer and the multi panel for the 
communications interface. 

2. Connect the multi panel to the configuration computer and set the multi panel to Transfer 
mode. (See the hardware manual for your multi panel.) 

3. Use ProSave to download WinAC MP runtime files from the configuration computer to the 
multi panel. 

4. Use ProSave to download authorization for WinAC MP from the configuration computer 
to the multi panel. 

5. Use ProTool CS to download the example your ProTool project or the WinAC example 
project from the configuration computer to the multi panel. 

 

MP370

ProTool Project with WinAC MP 
Example Screens

WinAC MP Runtime Files

ProSave 
ProTool CS 

Desktop Computer 

Ethernet, Serial, MPI/PROFIBUS, or USB 

 
Figure:   Download WinAC MP 

After you complete these tasks, you can download your hardware configuration and control 
program from STEP 7 to the WinAC MP controller on the multi panel.  

Note 
If you must perform an OS Update to reinstall ProTool on the multi panel, or to install a service 
pack, you replace all existing software and licenses installed on the multi panel. If you have an 
authorization installed on the multi panel, remove it according to the directions in “Removing an 
Authorization” (p.20) before you update the operating system. After the update, you must 
retransfer all of the WinAC MP components from the configuration computer and authorization 
diskette to the multi panel, as described in this chapter.  
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Setting Parameters for Communications 
WinAC MP supports the following interfaces for communications between the configuration 
computer and the multi panel:Error! Bookmark not defined. 

• Ethernet 

• Serial 

• MPI/PROFIBUS 

• USB 

You must set parameters in ProSave and ProTool on the configuration computer and also in the 
Control Panel utilities of the multi panel for the devices to communicate successfully. You use 
ProSave to download the WinAC MP runtime files to the multi panel, so you must configure 
communications parameters in both ProSave and the multi panel. You use ProTool to download a 
project with user interface screens, so you must configure communications parameters in both 
ProTool and the multi panel. ProSave and ProTool do not have to use the same communications 
protocol, but if they differ, you have to reconfigure your multi panel settings to match the tool you 
are using. 

Using the Remote Control Option 
The Remote Control option allows you to download from the configuration computer without 
having to set the multi panel to Transfer mode. Remote Control is especially useful when the 
configuration computer and the multi panel are not physically close to each other.  

Note 
To use the Remote Control option, ProTool must be running on the multi panel. The multi 
panel cannot automatically go to remote transfer mode when ProTool is not running. 

If ProTool is running on the multi panel and you have enabled Remote Control, the multi panel 
closes the ProTool runtime and begins accepting transferred files when you initiate a download 
from the configuration computer. A Remote Control download while WinAC MP is controlling the 
process can interfere with process activities. 

 

Warning 
If you select the Remote Control transfer option, it is possible for a user to download 
from the configuration computer to the multi panel while the controller is running.  

If the controller is connected to field equipment, interrupting its operation could cause 
death or serious injury to personnel and/or damage to equipment. 

Ensure that only qualified personnel have access to the configuration computer. Ensure 
that your equipment is in a safe state before proceeding with a download. Always install 
a physical emergency stop circuit for your machine or process. 

 

To enable Remote Control on the multi panel, follow these steps: 

1. From the Control Panel on the multi panel, open the Transfer utility. 

2. If you are using serial communication between ProTool and the multi panel, select the 
“Enable Channel” and “Remote Control” checkboxes for Channel 1 (Serial). 

3. If you are using MPI/PROFIBUS, Ethernet, or USB communication between ProTool and the 
multi panel, select the “Enable Channel” and “Remote Control” checkboxes for Channel 2. 
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Connecting the Configuration Computer to the Multi Panel 
You must use a direct connection for Serial, MPI/PROFIBUS, or USB communications. For 
Ethernet communication, you can use either a direct connection or a networked connection. To 
configure the multi panel to use a direct connection, follow these steps: 

1. From the Control Panel on the multi panel, open the Communications utility and select the 
PC Connection tab.  

2. Select the “Enable direct connections to the desktop computer” checkbox. 

Establishing Ethernet Communication 
To set up a direct Ethernet connection, connect a crossover cable between the multi panel and 
configuration computer. For a networked Ethernet connection, connect both the configuration 
computer and the multi panel to the local area network. Then, configure the following parameters: 
Ethernet Communication Parameters 
     

 On Your Configuration Computer...  On the Multi Panel...  
     

 To Connect from ProSave 
1. From the General tab of ProSave, 

select the Device Type  for your multi 
panel. 

2. From the Connection list, select 
Ethernet. 

3. Under Connection Parameters, supply 
the IP Address or Computer Name of 
the multi panel. 

  

    

 To Connect from ProTool CS 
1. Open the Download Preferences (File 

> Download > Preferences). The Set 
Download dialog opens. 

2. Select Ethernet from the list box. 
3. Supply the IP Address or Computer 

Name of the multi panel. 

 

Edit Network Configuration 
1. From the Control Panel, open the 

Network Configuration utility. 
2. From the Adapters tab, click the 

Properties button. 
3. Supply an IP address provided by 

your network administrator. 
Edit Transfer Settings 
1. From the Control Panel, open the 

Transfer utility. 
2. Under Channel 2, select Ethernet from 

the list. 
3. Select the Enable Channel checkbox. 
Save Your New Settings 
1. From the Control Panel, open the OP 

utility. 
2. Click the Save Registry button to save 

your configuration. Otherwise, your 
settings are reset to the default after 
the next power cycle. 

 

     

 

 

Warning 
Do not use DHCP (Dynamic Host Configuration Protocol) for TCP/IP address 
assignment on the multi panel.  

DHCP does not guarantee the return of the same IP address for the same node every 
time it is powered on. A changed IP address can cause nodes on the Industrial Ethernet 
to lose connection or to connect to the wrong node, which could cause unexpected 
process or machine operation resulting in death, serious injury and/or property damage. 

Always specify a static IP address for the multi panel, or at a minimum use DHCP with 
lease reservations. See your network administrator for address assignment. 
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Establishing Serial Communication 
To set up serial communication, you must connect a serial cable between the serial port on your 
configuration computer and the Config/Printer port on the multi panel, and configure the following 
parameters: 
 

Serial Communication Parameters 
     

 On Your Configuration Computer...  On the Multi Panel...  
     

 To Connect from ProSave 
1. From the General tab of ProSave, 

select the Device Type for your multi 
panel. 

2. From the Connection list box, select 
Serial. 

3. Under Connection Parameters, select 
the COM port that you are using on 
your configuration computer for this 
connection. 

4. Select the baud rate that is appropriate 
for your connection. 

  

    

 To Connect from ProTool CS 
1. Open the Download Preferences (File 

> Download > Preferences). The Set 
Download dialog opens. 

2. Select Serial from the list box. 
3. Select the COM port that you are using 

on your configuration computer for this 
connection. 

4.   Select the baud rate that is appropriate 
for your connection. 

 

Edit the Transfer Settings 
1. From the Control Panel, open the 

Transfer utility. 
2. Under Channel 1 (Serial), ensure that 

the Enable Channel check box is 
selected. 

Save Your New Settings 
1. From the Control Panel, open the OP 

utility. 
2. Click the Save Registry button to save 

your configuration. Otherwise, your 
settings are reset to the default after 
the next power cycle. 
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Establishing MPI/PROFIBUS Communication  

 Notice 
If you have downloaded a DP master hardware configuration from STEP 7 to the multi 
panel, you cannot perform MPI/PROFIBUS downloads from ProTool when WinAC MP is 
running on the multi panel. Shut down WinAC MP before downloading from ProTool or 
use another communications interface from ProTool to the multi panel. 

The communication settings on the multi panel must match the settings on the 
configuration computer.  

If you do choose to use MPI/PROFIBUS communication, you must install a card (such as 
CP 5611 for desktop PCs or CP 5511 for laptops) and driver on the configuration computer. You 
must connect an MPI/PROFIBUS cable between the 9-pin port of the card on the configuration 
computer and the DP/MPI/PPI port on the multi panel, and configure the following parameters: 
 

MPI/PROFIBUS Communication Parameters 
     

 On Your Configuration Computer...  On the Multi Panel...  
     

 To Connect from ProSave 
1. From the General tab of ProSave, 

select the Device Type for your multi 
panel. 

2. From the Connection list box, select 
MPI/PROFIBUS DP. 

3. Under Connection Parameters, supply 
the OP address that has been 
assigned to the multi panel. (The OP 
address is the same as the Address 
parameter in the S7-Transfer Settings 
utility.) 

  

    

 To Connect from ProTool CS 
1. Open the Download Preferences (File 

> Download > Preferences). The Set 
Download dialog opens. 

2. Select MPI/PROFIBUS DP from the list 
box. 

3. Supply the OP address that has been 
assigned to the multi panel. (The OP 
address is the same as the Address 
parameter in the S7-Transfer Settings 
utility.) 

 

Edit the S7-Transfer Settings 
1. From the Control Panel, open the S7-

Transfer Settings utility. 
2. Select MPI or PROFIBUS from the list. 
3. Click the Properties button. 
4. Ensure that the properties match 

those used by the configuration 
computer. 

Edit the Transfer Settings 
1. From the Control Panel, open the 

Transfer utility. 
2. Under Channel 2, select MPI from the 

list box. 
3. Select the Enable Channel check box. 
Save Your New Settings 
1. From the Control Panel, open the OP 

utility. 
2. Click the Save Registry button to save 

your configuration. Otherwise, your 
settings are reset to the default after 
the next power cycle. 
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Establishing USB Communication 
To set up USB communication, you must connect a USB cable between the USB port on the 
configuration computer and the USB port on the multi panel, and configure the following 
parameters: 
USB Communication Parameters 
     

 On Your Configuration Computer...  On the Multi Panel...  
     

 To Connect from ProSave 
1. From the General tab of ProSave, 

select the Device Type for your multi 
panel. 

2. From the Connection list box, select 
USB. (There are no other parameters 
to configure.) 

  

    

 To Connect from ProTool CS 
1. Open the Download Preferences (File 

> Download > Preferences). The Set 
Download dialog opens. 

2. Select USB from the list box. 

 

Edit Transfer Settings 
1. From the Control Panel, open the 

Transfer utility. 
2. Under Channel 2, select USB from the 

list box. 
3. Select the Enable Channel check box. 
Save Your New Settings 
1. From the Control Panel, open the OP 

utility. 
2. Click the Save Registry button to save 

your configuration. Otherwise, your 
settings are reset to the default after 
the next power cycle. 
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Downloading WinAC MP Runtime Files 
To be able to run WinAC MP on the multi panel, you must download the WinAC MP runtime files 
from the configuration computer to the multi panel. To transfer the runtime files that include the 
WinAC MP controller software, follow these steps: 

1. Select Transfer from the Loader dialog on the multi panel if it is not already in Transfer 
mode. The multi panel displays a "Connecting to host" message. 

2. Open ProSave on the configuration computer.  

3. From ProSave, click the General tab and select the device that corresponds to your multi 
panel (MP370, MP370 TOUCH, or MP370 15” TOUCH) from the Device Type list. 

4. In the Connection list box, select the type of connection that you are using between the 
configuration computer and the multi panel. See the topic “Setting Parameters for 
Communications” (p.8) for supported connection types and configuration instructions. 

5. Complete the Connection Parameters for your connection: 

y For an Ethernet connection, supply the IP address or computer name of the multi 
panel. 

y For a serial connection, select the COM port and baud rate. 

y For an MPI/PROFIBUS connection, supply the OP address of the multi panel. 

 
Figure: Setting Connection Parameters 
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6. Select the Options tab and click the Device Status button with the multi panel in Transfer 
mode. The communication connection is valid if you do not see an error message. 

Note 
If you have a communication problem, check that the multi panel is in Transfer mode, 
check your physical cable connections, and check that your settings in ProSave and on 
the multi panel are correct for your connection, as described in “Setting Parameters for 
Communications” (p.8). 

7. From the Options tab, click WinAC MP V3.1 in the Available Options (left pane) to select 
it, then click the  button to add it to the installed options of the multi panel (right pane).  

If an earlier version of WinAC MP has already been installed, you are warned that this 
option is already installed. You must use the  button to remove it from the Installed 
Options pane first. Then you can select WinAC MP from the Available Options and add 
(reinstall) it to the multi panel.  

ProSave begins downloading the WinAC MP controller software to the multi panel. While 
the transfer is in progress, the configuration computer displays progress on the transfer. 
On the multi panel, the Transfer dialog updates with messages containing progress on 
the files that the multi panel is receiving, uncompressing and writing to the flash file 
system. At the end of the transfer, a message confirms the success of the transfer. 

 
Figure: Transferring the WinAC MP Controller to the Multi Panel 

8. When the transfer completes, shut down and restart the multi panel. 

The WinAC MP controller is now installed on the multi panel. You do not have a user interface to 
the controller until you download a ProTool project with WinAC MP screens. 

Leave ProSave open to download WinAC MP authorization to the MP370. 



Transferring WinAC MP to the Multi Panel 
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Downloading Authorization for WinAC MP 
You use ProSave to transfer WinAC MP authorization from an authorization diskette inserted in 
the drive of your configuration computer to the multi panel. If ProSave is not already open, click 
SIMATIC > ProSave > ProSave from the Windows Start menu. 

To transfer the authorization, select Transfer from the Loader dialog on the multi panel. The multi 
panel opens a communications connection and displays a "Connecting to host" message. 

 

 

Notice 
You must ensure that the WinAC MP controller is shut down when you use ProSave to 
download files. 

If you attempt to perform downloads from ProSave while the WinAC MP controller is 
running, the controller process interferes with the download process. The controller 
process takes precedence and the other operation fails. You may not receive any 
notification that the process has failed. 

Always shut down the WinAC MP controller before you download files from ProSave. 

 

To transfer WinAC MP authorization to the multi panel using ProSave, follow these steps: 

1. Click the Authorize tab in ProSave. 

2. Select the drive letter for the drive where you have inserted the authorization diskette. 
The authorization is displayed in the Selection pane. The License counter should display 
a value of 001 for the WinAC MP authorization, indicating that the license is present on 
the diskette. (You can use the Device Status button to read the multi panel in order to see 
whether an authorization has already been installed.) 

3. To transfer the authorization from the diskette to the multi panel, select the product 
authorization in the Selection pane and use the  button to add it to the Installed 
Options. 

After the authorization transfer completes, you can exit ProSave. 

 

Caution 
Do not dispose of your authorization diskette! If you later want to reload the multi panel 
image, or perform a backup restore, you must first remove the authorization for 
WinAC MP from the multi panel (that is, transfer it back onto the diskette). The 
authorization can only be transferred back onto the original authorization diskette, as 
described in “Removing Authorization for WinAC MP from the Multi Panel” (p. 20). 

Authorization for WinAC MP is not backed up when you back up the flash memory of the 
multi panel, nor is it a part of the image on the multi panel. Consequently, if you do not 
uninstall the existing authorization (restore it from the multi panel to the diskette) before 
loading a new image or restoring from backup to the multi panel, the authorization 
information is erased during the load operation, effectively causing you to lose the 
authorization.  

If you lose an authorization, you must contact Siemens technical support for assistance. 
See the topic “Contacting Customer Support” (p. iv) for contact information.  
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Downloading a WinAC MP Example ProTool Project 
The ProTool example projects provide a user interface for the WinAC MP controller. You use 
ProTool CS to download an example project to the multi panel, or to create and download a 
custom ProTool project for your application. 

To download a project, select Transfer from the Loader dialog on the multi panel. The multi panel 
opens a communications connection and displays a "Connecting to host" message. 

Opening a ProTool Example Project 
From the Windows Start menu, click Start > SIMATIC > ProTool Pro CS to open ProTool CS. 
There are separate ProTool example projects for the MP370, the MP370 Touch, and MP370 15” 
Touch panels.  

The way that you access the example projects depends on whether or not you have selected 
"ProTool Integration in STEP 7" (from the File menu in ProTool). To open the example project 
that is appropriate for your multi panel, use the File > Open menu command to access the Open 
dialog. Then choose the procedure that is right for you: 

If you have selected ProTool Integration into STEP 7, 
1. From the Entry Point list, select Example project. 

2. From the Name list, select Zen08_01_WinACMP_Panel. 

ProTool CS displays the project location in the Storage Path field. The WinAC MP 
example project is in the STEP 7 installation directory under 
…\Step7\Examples\ZEN08_01. 

3. Click the ProTool icon that corresponds to your multi panel. ProTool CS displays its name 
in the Object Name field and its type (SIMATIC OP) in the Object Type field. 

4. Click the OK button to confirm your entries and open the example project. 

If you have not selected ProTool Integration into STEP 7, 
1. From the Open dialog, navigate to the ProTool project for your multi panel. 

The WinAC MP STEP 7 example project in the STEP 7 installation directory includes the 
three ProTool projects in the following locations: 

y Keyboard Unit: 
…\Step7\EXAMPLES\ZEN08_01\TDOP\PRO.PDB 

y Touch panel unit:  
…\Step7\EXAMPLES\ZEN08_01\TDOP\PRO___00.PDB 

y 15” Touch panel unit:  
…\Step7\EXAMPLES\ZEN08_01\TDOP\PRO___01.PDB 

2. Click the Open button to open the example project file that you have selected. 
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Downloading an Example Project 

To download an example project to the multi panel, click the Download button .  ProTool CS 
and the multi panel display progress indicators while the download is in progress. ProTool CS 
displays a success message following a successful download. 

If there are communication difficulties, try these troubleshooting tips: 

y Make sure that power is on to the multi panel and the multi panel is in Transfer mode.  

y Check that the cable is connected properly to the configuration computer and to the multi 
panel. 

y Review the topic “Setting Parameters for Communications” (p.8) to ensure that you have 
configured the connection properly. 

After a successful download, the multi panel displays a screen from the example project. The 
default is the WinAC_MP_Panel screen: 

 
Figure:   WinAC_MP_Panel Screen 

The chapter “Controlling Your Process with WinAC MP” describes how to use the example 
ProTool project in more detail.  

To use the example ProTool project for process monitoring and control, you must download a 
STEP 7 control program to WinAC MP, as described in the chapter “Developing and Downloading 
a STEP 7 Project for WinAC MP”. 
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Getting Started with WinAC MP on the Multi Panel 
After you transfer the runtime files, authorization and a WinAC MP example ProTool project, you 
can view and experiment with the user interface of the controller.  

Remember that the controller does not actually contain any program logic until after you 
download a STEP 7 control program. 

Starting the ProTool Project on the Multi Panel 
It is easy to start your ProTool project on the multi panel: 

1. Ensure that the multi panel is powered on. 

2. From the Loader dialog on the multi panel, click the Start button. ProTool opens and 
displays your project. 

Starting the WinAC MP Controller 
The type of multi panel you have determines how you start the controller: 

y Keyboard units: press the S3 key to start the controller. 

y Touch panel units: touch "Start WinAC MP" to start the controller. 

Shutting Down the WinAC MP Controller 
The type of multi panel you have determines how you shut down the controller: 

y Keyboard units: press the S4 key to shut down the controller. 

y Touch panel units: touch "Shutdown WinAC MP" to shut down the controller. 

Exiting the ProTool Project 
The type of multi panel you have determines how you exit the project: 

y Keyboard units: press the S2 key to exit ProTool. 

y Touch panel units: touch "Exit ProTool" to exit ProTool. 

The Difference Between Shutting Down WinAC MP and Exiting ProTool 
Exiting ProTool has no effect on the operation of the WinAC MP controller. When you exit 
ProTool, you close the project that provides the interface to the WinAC MP controller. You cannot 
see a representation of the controller. However, the controller can run even if the ProTool project 
is closed. 

When you start the WinAC MP controller, the power LED on the control panel representation in 
the example ProTool project turns green, and it stays green until you issue the "Shutdown 
WinAC MP" (S4) command. You can exit and restart ProTool on the multi panel and the power 
LED will remain green. 

To shut down the controller, press the S4 key or the touch button for the "Shutdown 
WinAC MP" command, which is entirely separate from the "Exit ProTool" command. 



Transferring WinAC MP to the Multi Panel 

 

 19

Restrictions when the Controller Is Running 
When the controller is running, the multi panel cannot connect to other PLCs. The WinAC MP 
controller is configured to use the IP address of the multi panel. Remember that the controller can 
be running whether or not ProTool is running on the multi panel. 

The following restrictions apply when the controller is running:  

y Do not attempt to perform ProSave operations between the configuration computer and 
the multi panel.  

y Do not use utilities from the Control Panel of the multi panel. The WinAC MP controller 
has priority over these other operations on the multi panel. Such operations, if attempted, 
may fail without notice.  

 Notice 
Ensure that the WinAC MP controller is shut down when you use ProSave to download 
files or when you use utilities in the Control Panel of the multi panel. 

If you attempt to perform downloads from ProSave or use utilities in the Control Panel 
while the WinAC MP controller is running, the controller process interferes with the 
download and/or Control Panel processes. The controller process takes precedence and 
the other operations can fail. You may not receive any notification that the process has 
failed. 

Always shut down the WinAC MP controller before you perform a download from 
ProSave or use a utility in the Control Panel of the multi panel. 

y Do not attempt to download a project from ProTool CS on the configuration computer to 
the multi panel when the controller is in RUN or RUN-P mode. 

 

Warning 
Downloading a ProTool CS configuration to the multi panel while the WinAC MP 
controller is in RUN or RUN-P mode interrupts the execution of the process. 

If process equipment is not in a safe state, interrupting the execution of the process 
could result in death or serious injury to personnel, and/or damage to equipment. 

Shut down the WinAC MP controller or set it to STOP mode prior to downloading any 
ProTool CS configuration. Ensure that your equipment is in a safe state. Always install a 
physical emergency stop circuit for your machine or process. 
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Removing WinAC MP 
To remove WinAC MP from both the configuration computer and the multi panel, you must 
perform the following tasks: 

y Remove the authorization license from the multi panel. 

y Remove the WinAC MP runtime files from the multi panel. 

y Remove WinAC MP V3.1 from the configuration computer. 

Removing Authorization for WinAC MP from the Multi Panel  
To remove the authorization from the multi panel and restore it to the authorization diskette, 
follow these steps: 

7. Insert the authorization diskette in the appropriate diskette drive of your configuration 
computer. 

8. To open ProSave, click SIMATIC > ProSave > ProSave from the Windows Start menu. 

9. Click the General tab and select the device that corresponds to your multi panel (MP370, 
MP370 TOUCH, or MP370 15” TOUCH) from the Device Type list. 

10. From the Connection list, select the type of connection that you are using between the 
configuration computer and the multi panel. 

11. Complete the Connection Parameters for your connection: 

y For an Ethernet connection, supply the IP address or computer name of the multi 
panel. 

y For a serial connection, select the COM port and baud rate. 

y For an MPI/PROFIBUS connection, supply the OP address of the multi panel. 

12. Click the Authorize tab. 

13. Click the Device Status button to read the authorization from the multi panel. ProSave 
displays the authorization in the Installed Options (right pane). 

Note 
If you have a communication problem and the multi panel is in Transfer mode, check your 
physical cable connections, and check to make sure that your settings in ProSave and on 
the multi panel are correct for your connection. Review the topic “Setting Parameters for 
Communications” (p.8). 

14. Select the correct drive letter for the drive where you have inserted the authorization diskette. 
The contents of the authorization diskette are displayed in the Selection area (left pane). The 
License counter displays a value of 000 for the WinAC MP authorization, indicating that the 
license is not currently present on the diskette. 

15. To transfer the authorization from the multi panel to the diskette, select the product 
authorization in the Installed Options (right pane) and use the  button to transfer it to the 
Selection area (left pane). When the transfer operation is complete, the License counter 
displays a value of 001, indicating that the license is present on the diskette. 
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Removing WinAC MP from the Multi Panel 
To remove the WinAC MP runtime files from the multi panel, follow these steps. 

1. Shut down the WinAC MP controller on the multi panel. ProSave cannot remove the 
WinAC MP files if they are running on the multi panel. 

2. Exit ProTool. 

3. Select Transfer mode from the Loader dialog on the multi panel. 

4. In ProSave on the configuration computer, click the Options tab. 

5. From the Options tab, click the Device Status button to read the WinAC MP runtime files 
from the multi panel. The runtime files appear in the Installed Options (right pane). 

6. Click WinAC MP in the Installed Options (right pane), then click the  button to 
remove the WinAC MP runtime files from the installed options of the multi panel. This 
deletes the WinAC MP runtime files from the multi panel. 

Note 
If ProSave takes a suspiciously long time to remove WinAC MP from the multi panel, 
check the multi panel to see if there is an error message saying the files cannot be 
removed while a WinAC MP executable file is operating. This error message means you 
have not shut down the controller. 

Start ProTool on the multi panel, shut down WinAC MP, exit ProTool, switch to Transfer 
mode, and then reattempt the file removal from ProSave on the configuration computer. 

7. Respond to the reboot prompt on the multi panel (click Yes to reboot now, No to reboot 
later). 

After the runtime files are removed from the multi panel, you can exit ProSave. Your ProTool 
project with a WinAC MP user interface is still present on the multi panel, but it has no function 
because the controller has been removed. 

Removing WinAC MP from the Configuration Computer  
You use the Windows Add/Remove Programs procedure to remove (uninstall) the WinAC MP 
software components on your configuration computer. To remove WinAC MP, follow these steps: 

1. If ProSave, ProTool, and/or STEP 7 are running, exit them. 

2. Select the Start > Settings > Control Panel menu command to display the Windows 
control panel.  

3. Double-click the Add/Remove Programs icon to display the Add/Remove Programs 
Properties dialog. 

4. Select the entry for SIMATIC WinAC MP V3.1 and click the Add/Remove button. 

5. Follow the instructions of the dialogs to remove the WinAC MP software. (If the Remove 
Enable File dialog appears, click the No button if you are unsure how to respond.) 
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Developing and Downloading a STEP 7 Project for 
WinAC MP 

You can download the WinAC MP example STEP 7 project to WinAC MP on the multi panel, or 
you can develop your own STEP 7 project. This chapter describes tasks for working with either a 
new project or one of the example projects.  

Configuring the Multi Panel Communication Settings 
You can use either MPI/PROFIBUS or Ethernet communications between STEP 7 on the 
configuration computer and the multi panel. You cannot use Serial or USB communications. If 
you change your settings, cycle power on the multi panel for the changes to take effect. Refer to 
the sections “Ethernet Communication Parameters” or “MPI/PROFIBUS Communication 
Parameters” for complete instructions.  

Creating and Configuring a STEP 7 Project 
For a new STEP 7 project, you must perform the following tasks: 

y Create a project and a SIMATIC PC station with the SIMATIC Manager. 

y Create the control program logic. 

To use the WinAC MP controller as a master on a PROFIBUS-DP network, you must perform the 
following tasks:  

y Use the HW Config editor to configure the WinAC MP controller and configure the 
distributed I/O, or to modify the existing configuration of an example project. 

y Edit the PG/PC interface in STEP 7 so that you can use an MPI/PROFIBUS or an 
Ethernet connection to download the hardware configuration and user program to the 
multi panel. 

 

STEP 7 

PROFIBUS-DP Subnet

Multi Panel

WinAC MP
STEP 7 Hardware Configuration 
and User Program 

Configuration Computer 

MPI/PROFIBUS or Ethernet 

 
Figure:   Download STEP 7 Hardware Configuration and User Program 



Developing and Downloading a STEP 7 Project for WinAC MP 

 24

STEP 7 Connection Options 
You can use either an MPI/PROFIBUS connection or an Ethernet connection to communicate 
from STEP 7 on the configuration computer to the WinAC MP controller on the multi panel. 

MPI/PROFIBUS: 

The factory default setting of the MPI/PROFIBUS interface of the multi panel is MPI with a 
transmission rate of 187.5 Kbps. The first download from the configuration computer must 
use an MPI interface as the PG/PC interface parameter assignment. 

When you configure the WinAC MP controller as a PROFIBUS-DP master in the Hardware 
Configuration utility of STEP 7, and download this configuration, STEP 7 changes the 
MPI/PROFIBUS interface on the multi panel from MPI to PROFIBUS-DP communication. For 
subsequent downloads to the multi panel using PROFIBUS, you must change the PG/PC 
interface settings on the configuration computer from MPI to PROFIBUS, as described in the 
topic “Changing the PG/PC Interface from MPI to PROFIBUS-DP” (p. 30). 

Ethernet: 

If you configure the PG/PC interface on the configuration computer to use a TCP/IP 
connection to download the PROFIBUS-DP master configuration to the multi panel, you do 
not need to change your PG/PC interface settings to perform subsequent downloads from 
STEP 7. Your STEP 7 connection uses the Ethernet port of the multi panel, and is unaffected 
by the configuration of the MPI/PROFIBUS interface. 

Note 
In order to configure STEP 7 to use an Industrial Ethernet connection to the multi panel, you 
must have the SIMATIC NET networking software installed on your configuration computer. 
No networking software is needed on the multi panel. 
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Configuring the SIMATIC PC Station and the PROFIBUS-DP 
Network 
When you install WinAC MP, the setup process installs a STEP 7 example project for WinAC MP 
on your configuration computer. The WinAC MP example project is located with the STEP 7 
example projects in the STEP 7 installation directory at …\Step7\EXAMPLES\ZEN08_01. If you 
choose to use the example project, open it and proceed to the section entitled “Defining I/O 
Communication Settings and Network Properties” (p. 27). 

Configuring a SIMATIC PC Station for a new STEP 7 Project 
To create a new project for the WinAC MP controller, follow these steps: 

1. From the SIMATIC Manager, select File > New and enter a project name such as 
MyNewProject. 

2. With your project selected, use the menu command Insert > Station > SIMATIC PC 
Station to create a SIMATIC PC station. 

 Figure:   Inserting a PC Station 
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3. In the left pane of the SIMATIC Manager, double-click the newly created station. This 
causes the Configuration icon to appear in the right pane. Double-click the Configuration 
icon to open the HW Config editor. 

 Figure:   Opening the SIMATIC PC Station 

4. If the HW Catalog is not already open, click the  icon to open it. 

Figure:   Hardware Configuration 

5. From the HW Catalog, navigate to SIMATIC PC Station\Controller\WinLC MP. Open the 
folder containing the order number and drag the V3.1 controller to slot 2. The Properties 
– PROFIBUS interface DP dialog appears. 

You have now configured the SIMATIC PC Station with WinLC MP in your STEP 7 project. The 
next step is the definition of the communication settings and network properties. 
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Defining I/O Communication Settings and Network Properties 
For WinAC MP to communicate to a network of distributed I/O, you must configure a 
PROFIBUS/DP subnet.To configure the SIMATIC PC station as a DP master that can be 
downloaded to the WinAC MP controller on the multi panel, follow these steps: 

1. From the Parameters tab of the Properties – PROFIBUS interface DP dialog, enter the 
node address for the WinAC MP controller on the multi panel. The default address for the 
DP master is 2. Each node on the network must have a unique node address between 0 
and 125.  

Note 
STEP 7 displayed the Properties – PROFIBUS interface DP dialog when you dragged the 
V3.1 controller to slot 2, as described in the preceding section. If this dialog is not open, 
double-click DP in the IF1 slot for WinLC MP in the Hardware Config utility. Then click the 
Properties button on the Properties – DP dialog. 

2. Click the New button to open the Properties – New subnet PROFIBUS dialog. From the 
General tab, you can assign a name for the network, or you can use the default name. 

3. Select the Network Settings tab. Examine the following settings and make changes if 
necessary: 

y Highest PROFIBUS Address: Can be reduced to improve polling speed, if you are 
certain you will never exceed a certain number of stations. 

y Transmission Rate: Default is 1.5 Mbps. Adjustable up to 12 Mbps depending on the 
speed requirement of the application. 

y Profile: Default is DP. 

For more information about PROFIBUS-DP communications and how to set up 
PROFIBUS networks, refer to the SIMATIC NET PROFIBUS User Manual. 

4. Click the OK button to confirm the name and any changes to the network settings that 
you have configured for the PROFIBUS subnet and close the Properties – New subnet 
PROFIBUS dialog. 

5. Click the OK button to confirm the node address that you have configured for the 
SIMATIC PC station and close the Properties – PROFIBUS interface DP dialog. 



Developing and Downloading a STEP 7 Project for WinAC MP 

 28

Configuring an Ethernet Connection between STEP 7 and the Multi Panel 
If you are using an Ethernet (TCP/IP) connection, you must perform additional tasks from the HW 
Config utility. For TCP/IP communication between STEP 7 and the multi panel using a static IP 
address, follow these steps: 

1. Select an IE General from the CP Industrial Ethernet folder of SIMATIC PC Station in the 
Hardware Catalog and drop it in any slot of the SIMATIC PC Station rack. The 
Properties - Ethernet Interface IE General dialog opens. 

2. In the IP Address field, enter the IP address of the multi panel. You can access Network 
Configuration from the Control Panel on the multi panel to find the IP address. 

3. For the subnet, select an Ethernet subnet. If one does not exist, click New. The 
Properties – New subnet Industrial Ethernet dialog opens. Click OK and a new Ethernet 
subnet is created for you.  

4. Click the OK button to complete the configuration of the Ethernet interface. 

For more information about Ethernet communications and setting up Ethernet networks, refer to 
the SIMATIC NET Ethernet User Manual. 

Before you close the HW Config editor, you can configure additional PROFIBUS nodes (slaves) 
according to your application requirements.  

When finished, click the save and compile icon  to save and compile the configuration. 
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Downloading the Configuration 
To download the hardware configuration to the WinAC MP controller on the multi panel, you must 
first set the PG/PC interface on the configuration computer to the type of connection, 
MPI/PROFIBUS or Ethernet (TCP/IP), that you are using between the configuration computer and 
the multi panel. 

Note 
If you use an MPI/PROFIBUS connection, you must set the PG/PC interface to MPI with 
a transmission rate of 187.5 Kbps for the first download to match the default settings of 
the mulit panel. You must then change it to a PROFIBUS-DP connection after 
downloading the DP master hardware configuration, as described in “Changing the 
PG/PC Interface from MPI to PROFIBUS-DP” (p. 30). 

To set the PG/PC interface, follow these steps: 

1. From the SIMATIC Manager, select Options > Set PG/PC Interface. 

2. Examine the Interface Parameter Assignment Used field. If it does not show the 
appropriate interface parameter, select an interface from the list. For example, select 
CP5611(MPI) or CP5611(PROFIBUS) for a CP5611 card, or a TCP/IP option that 
corresponds to an Ethernet card in your PC. 

3. Set the Properties for the Interface Parameter Assignment according to your type of 
connection: 

MPI/PROFIBUS: Set the baud rate for the first download to 187.5 Kbps and use an MPI 
interface. This is the default setting for the multi panel.  

Ethernet (TCP/IP): Click the Properties button and deselect the checkbox for “Fast 
Acknowledge”. You cannot download from STEP 7 to the multi panel if Fast Acknowledge 
is selected.  

4. Click the OK button to accept the card configuration and close the window. 

Before you download the configuration, check the following: 

• Ensure that WinAC MP is executing on the multi panel. Start the WinAC MP ProTool 
project if it is not already running. If WinAC MP is shut down, press the Start WinAC MP 
key (S3 on the keyboard unit) or touch the Start WinAC MP button (touch panel unit). 

• Ensure the multi panel is ready for a Transfer. If you have set the Remote Control option 
and a ProTool project is running, the multi panel can receive a transfer from the 
configuration computer. If Remote Control is not set, exit ProTool and select Transfer. 
The multi panel displays a Transfer dialog with a “Connecting to host” message, and is 
ready for a transfer.  For information on remote control, see “Using the Remote Control 
Option” (p.8). 
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To download the configuration, follow these steps: 

1. From the Hardware Config utility on the configuration computer, click the  icon to 
download the configuration of the STEP 7 project. 

2. On the Select Target Module dialog, highlight only the WinLC MP module selection and 
click the OK button. The Select node address is displayed. 

3. For MPI/PROFIBUS connections, enter the Station Address of the multi panel: use the 
address that is currently configured for the multi panel, not the new address that you are 
assigning. The default multi panel address, if you have not previously made an address 
assignment, is MPI 2 or PROFIBUS 2.  

For Ethernet connections, verify that the IP address of the multi panel is correct and click 
OK. 

STEP 7 downloads the hardware configuration to the WinAC MP controller and sets the 
MPI/PROFIBUS interface on the multi panel to PROFIBUS-DP. A dialog confirms whether the 
download is successful. 

If you used an Ethernet connection to the multi panel, you can continue to perform Ethernet 
downloads to the multi panel and do not need to make changes to the PG/PC interface settings in 
STEP 7. 

(Optional) Changing the PG/PC Interface from MPI to PROFIBUS-DP 
If you used an MPI connection to the multi panel, that connection is no longer functional. 
Downloading the DP master hardware configuration changed the port protocol from MPI to 
PROFIBUS-DP on the multi panel. You cannot use the MPI connection to the multi panel. 

In order to perform subsequent downloads to the WinAC MP controller from STEP 7, you must 
switch your PG/PC interface to PROFIBUS-DP, and define the communications settings from the 
values you noted in the subnet properties of the PROFIBUS-DP master. To change your PG/PC 
interface, follow these steps: 

1. From the SIMATIC Manager, select Options > Set PG/PC Interface. 

2. Select the interface parameter corresponding to the CP card in your configuration 
computer using the PROFIBUS-DP bus profile, for example, CP5611(PROFIBUS). 

3. Click the Properties button. 

4. In the Properties dialog, enter the same values for Network Parameters that you noted for 
the subnet properties, as described in the section “Defining I/O Communication Settings 
and Network Properties” (p. 27). 

y Transmission Rate 

y Highest Station Address (Highest PROFIBUS Address field in Properties dialog for 
the PROFIBUS subnet) 

y Profile (DP) 

 Note 
The Address field contains the address of the configuration computer (default 0), not the 
address of the SIMATIC PC station (default 2). Leave it as it is. 

5. Click the OK button to confirm your work and close the Properties dialog. 

6. Click the OK button to confirm your work and close the PG/PC Interface dialog. 
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Testing the Online Connection 
After you complete the network configuration, verify that the connection between STEP 7 and the 
WinAC MP station is operational. 
Testing the Online Connection 

 
You can verify the connection from the SIMATIC Manager by clicking the online 
icon. 

 
If you are communicating directly over the PROFIBUS-DP network from the 
configuration computer to the multi panel (not using an Ethernet connection), you 
can also test the connection by selecting the Accessible Nodes icon. The 
PROFIBUS node of the multi panel appears in the list of network nodes. 

If the network configuration is not online, review the steps of the network configuration as 
described in the preceding topics and correct any errors.  

Developing and Downloading the User Program 
Develop your control program in the STEP 7 project, creating and editing the blocks necessary 
for control of your process. Download the created blocks either from the SIMATIC Manager or 
from the STEP 7 option that you used to create the blocks. For detailed information about 
developing a project using STEP 7, refer to your STEP 7 documentation. 
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Controlling Your Process with WinAC MP 
This topic describes how to control your process with WinAC MP by using an example ProTool 
project. You can also customize the example project screens or create your own screens as 
described in “Customizing WinAC MP for Your Application” (p. 45). 
If you have successfully completed the procedures described in the topics “Transferring 
WinAC MP to the Multi Panel” (p.7) and “Developing and Downloading a STEP 7 Project” (p.23), 
you now have an executable control program loaded in the WinAC MP controller, and an 
interface (the example ProTool project) from which to control it. Additionally, you may have 
developed screens with ProTool CS for your specific process application. The initial screen 
displayed on the multi panel when you download the example ProTool project is the 
WinAC_MP_Panel screen. From this screen, you can perform WinAC MP functions, view all of 
the WinAC MP status indicators, change the operating mode of the controller, and monitor scan 
cycle data:  

 
Figure:   WinAC_MP_Panel Screen 
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Functions Available from the Example Screens  
The table below describes the functions available from the WinAC MP example screens, and lists 
the key equivalents for the MP370 keyboard unit. The key assignments are not applicable for the 
MP370 touch panel units, where you simply touch a button on the screen to select it. 
 

Key Function Name Function Description 
S2 Exit ProTool Exits ProTool RT. It does not shut down the 

WinAC MP controller. 
S3 Start WinAC MP Starts the WinAC MP controller on the multi panel.  
S4 Shutdown WinAC MP Shuts down the WinAC MP controller. When 

WinAC MP is shut down, the controller and control 
program are not executing. 

Clear Histogram Data 
 
(WinAC_MP_Panel screen) 

Clears the histogram buffer of cycle time data S5 

Start at Boot 
 
(WinAC_MP_Function screen)

Allows you to configure whether or not the 
WinAC MP controller starts automatically when the 
Multi Panel is powered on.  
Cyan: Start at Boot enabled; Gray: Start at Boot 
disabled 

S6 Autostart Allows you to enable the WinAC MP controller to 
start in RUN mode under conditions described in 
“Enabling the Autostart Feature” (p.38)  
Cyan: Autostart enabled; Gray: Autostart disabled 

S7 Archive Save the control program to an archive file. 
S8 Restore Restore the control program from an archive file. 
F1, F2 Switch Between Screens Switches the display from one screen to the next on 

the multi panel. 
 

Note: Starting the ProTool project or exiting it has no effect on whether the WinAC MP 
controller is executing or shut down. The WinAC MP controller can be executing 
regardless of whether the ProTool screens are displayed or not. 
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Status Indicators 
The WinAC MP Control Panel that is shown in the ProTool example project displays the normal 
status indicators found on a WinLC Control Panel or on an S7-300/400 controller. These 
indicators are view-only: you cannot use them to change modes or set faults in the WinAC MP 
controller.  

The status indicators are described below: 
 

Indicator Description 
ON The ON indicator is on when the WinAC MP controller is running. 

The ON indicator is off when a shutdown of the WinAC MP controller finishes 
saving the program and states to the flash file system. 

BATF Battery fault. Always off for WinAC MP. 
INTF Internal fault. This indicator lights up (solid) to show error conditions that exist 

within the controller, such as programming errors, arithmetic errors, timer errors 
and counter errors. 

EXTF External fault. This indicator lights up (solid) to show error conditions that exist 
outside of the controller, such as hardware faults, parameter assignment errors, 
communication errors, and I/O fault errors. 

BUSF1 
 

The BUSF1 indicator flashes to identify fault conditions in the communication with 
the distributed I/O. 

FRCE This indicator lights up (solid) to show that a force request in active. Not 
applicable for WinAC MP. 

RUN 
STOP 

The RUN indicator lights up when the operating mode is RUN. 
The STOP indicator lights up when the operating mode is STOP. 
The RUN indicator blinks at 2Hz and the STOP indicator lights up (solid) when 
the WinAC MP controller is executing a restart. 
The RUN indicator blinks at 0.5Hz and the STOP indicator lights up (solid) when 
the WinAC MP program has reached a breakpoint. 
The STOP indicator flashes slowly when WinAC MP requires a memory reset. To 
recover from this condition, perform a memory reset (MRES). 

All status 
indicators 
flashing 

When all of the status indicators are flashing, the WinAC MP controller has 
encountered an error condition that cannot be fixed by resetting the memory 
(MRES). To recover from this condition, you must perform the following tasks: 

1. Shut down the WinAC MP controller. 
2. Restart the WinAC MP controller. 
3. Reset the memory (MRES). 

 

The example projects that are supplied with WinAC MP have all of the functionality described 
above. If you want to change anything on the example project screens, or put WinAC MP control 
functions or indicators on any of your other application screens, refer to the topic “Customizing 
WinAC MP for Your Application” (p. 45). 
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Operating Mode Change Buttons 
Both example screens contain a WinAC MP control panel from which you can change the 
operating mode of the controller. The mode change buttons correspond to global keys on the 
MP370 keyboard unit and to touch buttons on the MP370 Touch (12” or 15”).  

 

Warning 
Do not attempt to download from ProTool CS to the multi panel when the controller is in 
RUN or RUN-P mode. 

Downloads from ProTool CS while the controller is running interrupt process control and 
could cause death, serious injury and/or property damage. 

Always put the controller in STOP mode, or shut down WinAC MP before downloading 
from ProTool CS. 

The operating modes are described below: 
 

Key Operating Mode Description 
S12 RUN-P Put the WinAC MP controller in RUN-PROGRAM Mode. When the 

controller is in RUN-P mode, you can: 
y Upload a STEP 7 program from the controller to your 

configuration computer. 

y Download a STEP 7 program from your configuration 
computer to the controller. 

y Download individual STEP 7 blocks to the controller. 

y Use external software (such as STEP 7) to change the 
operating mode of the controller. 

S13 RUN Puts the WinAC MP controller in RUN Mode. In RUN mode you 
can upload a program from the controller to your configuration 
computer, but you cannot download a program to the controller. 

S14 STOP Puts the WinAC MP controller in STOP Mode. The program stops 
executing. You can perform program uploads and downloads, and 
you can download from ProTool CS. 

S15 MRES Resets the WinAC MP controller memory. This includes resetting 
the hardware configuration, deleting the WinAC MP program, and 
resetting the memory areas (I,Q,M,T, and C). 

Performing a Memory Reset (MRES)  
A memory reset (MRES) erases the STEP 7 project from the WinAC MP controller. You must 
download your project from STEP 7 again before the WinAC MP controller can resume process 
control.  



Controlling Your Process with WinAC MP 

 

 37

Clearing Histogram Data 
The WinAC MP controller maintains a buffer of scan cycle time data and uses this historical data 
to compute and display the last cycle time, the average cycle time, and the maximum and 
minimum cycle times. The WinAC_MP_Panel screen displays these values numerically, and in a 
histogram. The histogram displays the percentage of scan cycles executing at the recorded scan 
cycle times. 

To empty this buffer of data, press the Clear Histogram Data key (keyboard unit) or touch the 
Clear Histogram Data touch button (touch panel units) on the WinAC_MP_Panel screen. When 
WinAC MP is running, it immediately begins collecting cycle time data again. The screen updates 
according to the new buffer of scan cycle times. 

Starting the Controller when the Multi Panel Boots 
By default, you must start the WinAC MP controller manually after the multi panel boots. You can, 
however, enable the controller to start automatically after the multi panel boots. If you enable the 
controller to start at boot, you can also use the Autostart feature to determine the initial operating 
mode. 

From the WinAC_MP_Function screen, the Start at Boot key or touch button acts as a toggle. 
When the button display is cyan, start at boot is enabled. When the button display is gray, start at 
boot is disabled. 

Enabling the Controller for Start at Boot 

To configure the WinAC MP controller to start automatically, select the Start at Boot key or touch 
button so that the button display is cyan. 

When enabled to start at boot, the WinAC MP controller starts automatically whenever the multi 
panel boots.  

Disabling the Controller for Start at Boot 

To configure the controller so that is does not start automatically, deselect the Start at Boot key 
(S7 on keyboard units) or Start at Boot touch button (touch panel units) so that the button display 
is gray. 

When you disable start at boot, WinAC MP does not start automatically whenever the multi panel 
boots. To start WinAC MP, you must start the ProTool project, and then use the Start WinAC MP 
key (S3 on keyboard units) or Start WinAC MP touch button (touch panel units). 
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Enabling the Autostart Feature 
WinAC MP includes an Autostart feature that defines whether the controller starts up in STOP or 
RUN mode when WinAC MP is configured to start at boot. If WinAC MP is configured for a 
manual start, then the controller always starts in STOP mode. The following table lists the 
parameters that the Autostart feature uses to determine the operating mode of the controller 
when it starts automatically after a boot of the multi panel. 

Mode at Shutdown Autostart Mode on Restart 

No STOP STOP 

Yes STOP 

No STOP RUN 

Yes RUN 

To enable or disable the Autostart feature, use the Autostart key (S6 on keyboard units) or 
Autostart touch button (touch panel units) from either of the ProTool project example screens. 
When the button display is cyan, Autostart is enabled. When the button display is gray, Autostart 
is disabled. 
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Archiving and Restoring Control Programs 
You can save the configuration and control program to an archive file. You can use this archive 
file like the removable memory cartridge of a hardware controller. Saving the configuration of the 
controller and the control program to an archive file makes it easy to restore the controller after a 
memory reset. However, the archive file does not function like the EEPROM cartridge of the 
hardware controller in that the WinAC MP controller does not automatically restore the archive file 
after a memory reset (MRES). You must manually restore the archive file.  

You can archive or restore a file only when the operating mode (keyswitch position) is set to 
STOP. 

Note 
You cannot archive or restore a file larger than 1 Mbyte. 

Creating an Archive File 

An Archive file stores the current control program, the current system configuration, and the initial 
values of the DBs. The Archive file does not store the configuration of the PC station. 

To create an Archive file, use the Archive key (S5 on keyboard unit) or the Archive touch button 
(Touch panel units) on either of the WinAC MP example screens. The Archive command displays 
a dialog that allows you to navigate and give a name to the file. You can save the archive file to 
the flash file, a memory card, or a remote computer. 

Note 
If you save an archive on the multi panel in a directory other than the Flash directory, the 
file is lost with the next reboot. To retain the archive file, use the Flash directory, or save 
it to a remote computer or removable storage media. 

You can also use the SIMATIC Manager of STEP 7 to create an Archive file. Select the File > 
Memory Card File > New menu command.  

Restoring an Archive File 

When you restore an archive file, you reload the configuration and the control program for the 
controller. You can restore archive files from the flash file, a memory card, or remote computer, 
depending on where you stored your archive files. 

Before you can restore an archive file, you must set the operating mode (keyswitch position) of 
the controller to STOP mode. To restore an archive file, follow these steps: 

1. Click the STOP key (S14 on the keyboard unit) to the STOP touch button (touch panel 
units) to place the controller in STOP mode. 

2. Select the the Restore key (S6 on the keyboard unit) or the Restore touch button (touch 
panel units). 

3. Select the specific archive file to restore from the dialog and click OK. 
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Understanding the Tuning Parameters 
The multi panel processor must perform both WinAC MP control program execution and ProTool 
screen processing. The example ProTool projects include a WinAC_MP_Panel screen that 
displays information about the cycle time, and enables you to change the Min Sleep Time value 
and observe its effect on the cycle time. The WinAC_MP_Panel screen is shown below: 

 
Figure:   WinAC_MP_Panel Screen 

Viewing Cycle Time Data 
The WinAC_MP_Panel screen provides output fields that display the last cycle time, average 
cycle time, maximum cycle time, and minimum cycle time, as well as a histogram of cycle times 
(the Histogram control).  The histogram shows the percentage of scans that occur at a particular 
scan time. The WinAC_MP_Panel screen also includes a Clear Histogram Data key (S7 on 
keyboard units) or Clear Histogram Data touch button (touch panel units) that resets the collected 
cycle time data. 
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Configuring the Minimum Sleep Time  
The minimum sleep time value allows you to ensure that there is always a specified amount of 
processing time between scan cycles available to processes other than the WinAC MP controller. 

The minimum sleep time value allows you to increase or decrease the execution time of the 
WinAC MP control program, which has an indirect effect on all other processes that are running 
on the multi panel. The default minimum sleep time for the WinAC MP controller is 50 ms, and the 
lowest allowed minimum sleep time is 1 ms. 
A high sleep time value increases the execution time of the control program by enforcing a sleep 
interval between scan cycles. The higher the sleep time value, the more processing time that is 
available to processes other than the WinAC MP controller. The net effect is to raise the 
processing time of ProTool on the multi panel relative to the processing time of the WinAC MP 
controller. 

A low sleep time value decreases the execution time of the user program by decreasing or 
eliminating the sleep time between scan cycles. The lower the sleep time value, the less 
processing time that is available to processes other than the WinAC MP controller. The net effect 
is to lower the processing time of ProTool on the multi panel insofar as the processing time of the 
WinAC MP controller is raised. If ProTool appears to be irregular or erratic in updating the 
screens, increase the minimum sleep time. Raising the minimum sleep time of the control 
program allocates more processing time for ProTool. 

Peer-to-Peer Communication Functions 
Like other S7 controllers, WinAC MP provides peer-to-peer communications between other S7 
controllers on the network. The controllers can be either hardware or software logic controllers. 
The table below lists the SFBs and SFCs that WinAC MP supports for peer-to-peer 
communications: 

SFB/SFC Designation Description 

SFB8 
SFB9 

USEND 
URCV 

Exchange data using a send and a receive SFB 

SFB12 
SFB13 

BSEND 
BRCV 

Exchange blocks of data of variable length between a send SFB and 
a receive SFB 

SFB14 
SFB15 

GET 
PUT 

Read data from a remote device 
Write data to a remote device 

SFB22 
SFB23 

STATUS 
USTATUS 

Specific query of the status of a remote device  
Receive status messages from a remote device 

SFC62 CONTROL Query the status of a connection that belongs to an instance of an 
SFB/FB 

For more information on these functions, refer to the System Software for S7-300/400 System 
and Standard Functions Reference Manual. To view this manual from a computer where STEP 7 
is installed, select the menu command Start > Simatic > Documentation > English, and 
double-click "STEP 7 - System and Standard Functions for S7-300 and S7-400". 
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Configuring the Retentive Data 
You can use the Retentive Memory tab of the STEP 7 Hardware Configuration tool to configure 
the following areas of memory to be retained in the event of loss of power or on a transition from 
STOP mode to RUN mode:  

• Number of Memory bytes: up to 2048 bytes (from MB0 to MB2047)  

• Number of S7 timers: up to 512 timers (from T 0 to T 511)  

• Number of S7 counters: up to 512 counters (from C 0 to C 511)  

In the event of an abnormal shutdown such as a loss of power while the controller is running, the 
current values for these areas, as well as the DBs, are lost. When you use the Shutdown 
WinAC MP key (S4 on keyboard units) or the Shutdown WinAC MP touch button (touch panel 
units) to perform a normal shutdown, WinAC MP retains the values according to the configured 
parameters shown in the table below: 

Note 
DBs that were created by SFC22 (CREATE_DB) are not retained following a cold restart. 
All other DBs are retentive following a normal shutdown.  

Parameter Description Range Default 

Memory Bytes Enters the number of memory bytes to 
be retained (starting from MB0) 

0 to 2048 

 

16 

 

S7 Timers Enters the number of S7 timers to be 
retained (starting from T 0) 

0 to 512 0 

S7 Counters Enters the number of S7 counters to be 
retained (starting from C 0) 

0 to 512 8 

Because the retentive data is not saved when a loss of power occurs, you can use SFC82 to 
SFC84 in your control program to save important data periodically. Then, when you restart 
WinAC MP following a power outage, you can retrieve the last data saved. 
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Using SFCs to Retain Data 
You can use SFC82 (CREA_DBL), SFC83 (READ_DBL), and SFC84 (WRIT_DBL) to save data 
at significant events in your process. For example, you may want to store the recipe values into 
Load memory when changing a recipe without downloading new blocks for the control program.  

  Caution 
Whenever your control program calls SFC82, SFC83, or SFC84, the SFC reads or 
writes data to the flash memory. If you call these SFCs every scan (such as from 
OB1) or from a cyclical OB that is executing rapidly, the constant reading or writing to 
the flash memory can cause the flash memory to fail or can cause jitter.  
You should only call SFC82, SFC83, or SFC84 to record a significant process event, 
such as a change of recipe. 

 

SFC82 and SFC84 modify the data for the control program that is stored in the Load memory. 
Saving the blocks to Load memory (instead of keeping the values in Work memory) ensures that 
these blocks are available even if WinAC MP cannot save the power-down state when shutting 
down the controller. 

SFC82, SFC83, and SFC84 create and update blocks that are stored as part of your control 
program in Load memory. The blocks are created or modified in Load memory when your control 
program executes these SFCs.  

SFC82, SFC83, and SFC84 are asynchronous SFCs that run in the background.  

Note 
If you call SFC82, SFC83, or SFC84 from the startup OB (OB100 or OB102), WinAC MP 
executes these SFCs synchronously. This differs from the operation of a hardware PLC. 

Like the other asynchronous SFCs, SFC82, SFC83, and SFC84 are typically long-running SFCs 
that can require a relatively long time to complete. (The time for the SFC call itself will be short, 
but the actual operation for the SFC will be executing in the background.) In order to use 
asynchronous SFCs, you must allow sufficient sleep time to allow WinAC MP to process the 
SFCs without encountering jitter.  

Note 
Do not use a polling loop that looks for the completion of an asynchronous SFC, 
especially for SFC82, SFC83, or SFC84. Because the asynchronous SFC is being 
executed in the background, having your control program loop until the SFC finishes will 
extend the execution of the OB that is performing the polling loop and can cause jitter. 
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Customizing WinAC MP for Your Application 
ProTool CS is the configuration system of ProTool and is used for the development of process 
visualization screens. ProTool RT is the runtime version of ProTool that runs on the multi panel. 
You download a project from ProTool CS on the configuration computer to ProTool RT on the 
multi panel. You use these screens on the multi panel for controlling and monitoring the process. 

You can use the example ProTool projects for the MP370, MP370 Touch, or MP370 15” Touch 
without modification. You can also use ProTool CS to modify an example project for your 
application, or to create a new project. The WinAC MP installation integrated all of the WinAC MP 
functions and ActiveX controls into ProTool CS. You can copy screens or screen objects from 
one project to another. To open ProTool CS, select the Start > SIMATIC > ProTool CS > 
ProTool Pro CS menu command. 

See your ProTool CS documentation for detailed information on contstructing screens and using 
the features of ProTool. 
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Mapping Functions in a ProTool Project 
With ProTool CS, you can design screens and map functions to control the display of controller 
data during runtime. You can map functions to Global Keys, Soft Keys, System Keys, input and 
output display fields, buttons, graphical displays, and other screen objects.  

You can configure events that define when these functions execute; for example, you can update 
the value in an output field whenever the tag value associated with that output field changes. You 
can configure events for the screen, so that when you enter a screen, the functions that you have 
configured for it execute.  

ProTool CS provides the capability to map functions to the following events, depending on the 
type of object being configured. 

Tag Values: 

y A tag value changes 

y A tag value is lower than the limit 

y A tag value is higher than the limit 

Button Events: 

y A button is clicked 

y A button comes up 

y A button goes down  

Screen Events: 

y A screen is entered 

y A screen is exited 

Field Events: 

y A field is entered 

y A field is exited  

Alarm Message Events: 

y An alarm message arrives 

y An alarm message departs 

y An alarm message is acknowledged 

Event Message Events: 

y An event message arrives 

y An event message departs 

y An event message is acknowledged 

Overflow Events: 

y An archive overflow occurs 

y A screen overflow occurs 

y A window overflow occurs 

y A password overflow occurs 

 

 

For information about mapping functions to keys, screen changes, field changes, or any of the 
activation mechanisms described above, refer to your ProTool CS documentation.  

The installation of WinAC MP added the WinAC MP functions to the set of functions already 
provided by ProTool. You can see these functions in ProTool CS in the WinAC MP function 
group. The WinAC MP example ProTool projects show how to use many of these functions.  
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WinAC MP Functions 
The following table describes all of the WinAC MP functions that are available when you build 
screens in ProTool CS. To update values displayed on a ProTool screen, you use the Update and 
Get functions. To set or change values in the controller, you use the Set functions.  

Name Description 
Archive Saves configuration and program file to flash file 
Clear_Cycle_Time_Buffer Clears the cycle time histogram data 
Control_WinAC_MP Start or shut down the WinAC MP controller 
Get_Sleep_Time Gets the value of the minimum sleep time of the WinAC MP 

controller (in milliseconds) 
Get_WinAC_MP_Start_Mode Gets the WinAC MP start mode (used in the example screens 

to display cyan or gray for the Autostart key/button) 
Get_WinAC_MP_Version Gets the release version number of WinAC MP 
Restore Loads configuration and program file from archived flash file 
Set_Key_Switch Sets the key switch of the WinAC MP controller to RUN-P, 

RUN, STOP, or MRES 
Set_Priority No effect 

In previous releases, this function set the priority of the 
WinAC MP controller high or low relative to ProTool. 

Set_Restart_Method Sets the restart method either to cold restart (CRST) or to warm 
restart (WRST) 

Set_Sleep_Time Set the minimum sleep time of the WinAC MP controller (in 
milliseconds) 

Set_WinAC_MP_Start_Mode Set the start mode of the WinAC MP controller (enable or 
disable Autostart) 

Set_WinAC_Start_At_Boot Sets whether or not WinAC MP is automatically started after 
multi panel boot 

Update_Average_Cycle_Time Updates the display of the average cycle time variable (in 
milliseconds) 

Update_Average_Exec_Time Updates the display of the average execution time variable (in 
milliseconds) 

Update_BATF_LED_Variable Updates the status indicator of the BATF LED variable 
Update_BUSF1_LED_Variable Updates the status indicator of the BUSF1 LED variable 
Update_BUSF2_LED_Variable Updates the status indicator of the BUSF2 LED variable. (No 

effect for WinAC MP V3.1) 
Update_Controller_for_Start_ 
at_Boot 

Gets the information of whether or not WinAC MP is 
automatically started after multi panel boot 

Update_EXTF_LED_Variable Updates the status indicator of the EXTF LED variable 
Update_FRCE_LED_Variable Updates the status indicator of the FRCE LED variable 
Update_INTF_LED_Variable Updates the status indicator of the INTF LED variable 
Update_Key_Switch_Setting Updates the display of the key switch setting 
Update_Last_Cycle_Time Updates the display of the last cycle time (in milliseconds). 
Update_Maximum_Cycle_Time Updates the display of the maximum cycle time (in 

milliseconds) 
Update_Minimum_Cycle_Time Updates the display of the minimum cycle time (in milliseconds) 
Update_Power_LED_Variable Updates the ON/OFF status indicator of the Power LED 

variable 
Update_Priority Updates the display of the priority of the WinAC MP controller 

relative to ProTool 
The priority value is always “High” for WinAC MP V3.1 

Update_RUN_LED_Variable Updates the status indicator of the RUN LED variable 
Update_STOP_LED_Variable Updates the status indicator of the STOP LED variable 
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You can use ProTool CS to configure any of the WinAC MP functions in your project. You must 
then download your ProTool project to the multi panel for process control. 

Note 
Functions that display a value (Get and Update functions) must be configured to the 
screen, or else the screen does not show the updates. The examples for configuring a 
screen output to display the average cycle time describe the use of screen events. 

To see how WinAC MP functions are used within ProTool, you can examine the mapping of 
functions to screen objects in one of the example projects.  

Using the WinAC MP ActiveX Controls 
The installation of WinAC MP added two ActiveX controls to ProTool CS. The WinAC_MP_Panel 
screen uses both of these controls. To insert one of these controls on a ProTool screen, copy it 
from the WinAC_MP_Panel screen, or click the appropriate icon in ProTool CS. The WinAC MP 
ActiveX controls are described below: 

Object Icon Description 

WinAC MP  Displays a control panel for the WinAC MP controller 

Histogram  Displays a histogram of scan cycle times for the WinAC MP controller 
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Saving, Compiling, and Downloading ProTool Projects  
After you finish your changes in ProTool CS, you must save, compile and download your 
configuration to the multi panel. 

To save a ProTool CS project, click  or select File > Save at any time. 

To compile your ProTool CS project work to date, click  or select File > Compile at any time. 

 

Warning 
Downloading a ProTool CS configuration to the multi panel while the WinAC MP 
controller is in RUN mode interrupts the execution of the process. 

If process equipment is not in a safe state, interrupting the execution of the process 
could result in death or serious injury to personnel, and/or damage to equipment. 

Shut down the WinAC MP controller or set it to STOP mode before you download any 
ProTool CS configuration. Ensure that your equipment is in a safe state. Always install a 
physical emergency stop circuit for your machine or process. 

 

To download your ProTool project from the configuration computer to the multi panel, follow these 
steps:  

1. Shut down WinAC MP on the multi panel.  

2. If you have Remote Control enabled on the multi panel, do not exit ProTool on the multi 
panel. ProTool RT can accept an automatic transfer when configured for Remote Control. 

If you do not have Remote Control enabled on the multi panel, exit ProTool and select 
Transfer from the Loader dialog on the multi panel. The multi panel opens a connection 
for your configuration computer and displays a "Connecting to host" message. 

3. Save, compile, and download your project from ProTool CS on the configuration 
computer. 

After you download a project to the multi panel, you can begin using it for process control. 
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Examples 
The following sections provide three examples of configuring objects in ProTool CS to work with 
the WinAC MP controller. An example for the keyboard unit explains how to configure a global 
key to start or shut down WinAC MP. An example for the touch panel unit shows how to configure 
a global touch button to start or shut down WinAC MP. The third example is for any type of multi 
panel and demonstrates how to configure an output field to display the average cycle time. 

Keyboard Unit Example: Configuring a Global Key to Start or Shut Down 
WinAC MP  
The Start WinAC MP and Shutdown WinAC MP keys are configured locally for each screen of the 
example project, but you might want to configure a global key that would work for every screen of 
the project. The Control_WinAC_MP function can be used to start the WinAC MP controller or 
shut down the WinAC MP controller. In this example, you learn how to configure a global key that 
shuts down the WinAC MP controller.  

Follow these steps to configure a global function key on the multi panel to shut down WinAC MP: 

1. Create or open a ProTool CS project with at least one screen.  

2. From ProTool CS, select System > Screen/Keys. ProTool CS displays the Screen/Keys 
dialog that displays the screen area and the keys on the multi panel.  

If you do not see keys on the dialog, you may have opened a project for a touch panel. If 
so, close the project and open or create a project for the MP370 multi panel. You also do 
not see the keys if you have clicked the Hide Keys button. Click the Display Keys button 
to display the keys on the keyboard unit. 

3. From the Screen/Keys dialog, click the function key that you want to map to shut down 
WinAC MP. ProTool displays the Function Key dialog and the Select Object dialog. If the 
Select Object dialog does not open automatically, select the checkbox for “Show 
Functions Available for Selection.” 

4. From the Function Key dialog, select Press Key () from the Selected Functions for Event 
list. (The number enclosed in the parenthesis marks indicates how many functions have 
been configured for this event on this key.) 

5. From the Select Object dialog, navigate to the WinAC MP function group, and click 
Control_WinAC_MP. 

6. Click the <<Add button. The Parameters-Control_WinAC_MP dialog opens. 

7. From the Parameters-Control_WinAC_MP dialog, select Shutdown_WinAC_MP for the 
winac parameter. 

8. Click OK to close the Parameters-Control_WinAC_MP dialog. 

9. Close the Select Object dialog. 

10. Click OK to close the Function Key dialog. 

The Screen/Keys dialog displays a green triangle in the lower corner of the key that you 
configured, indicating that a function is globally mapped to the key. 

11. Click OK to close the Screen/Keys dialog. 

Following successful configuration, the function key displays the green triangle in the Screen 
window for all the screens, indicating that the key is globally mapped.  

After you finish your changes in ProTool CS, you must save, compile and download your project 
to the multi panel. After a successful download, you can use the global key that you configured to 
shut down the WinAC MP controller from any ProTool screen on the multi panel.
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Touch Panel Unit Example: Configuring a Global Button to Start or Shut 
Down WinAC MP 
The Start WinAC MP and Shutdown WinAC MP functions are configured locally in each screen of 
the example project, but you might want to configure a global button that would work in every 
screen of the project. The Control_WinAC_MP function can be used to start the WinAC MP 
controller or shut down the WinAC MP controller. In this example, you learn how to configure a 
global button that shuts down the WinAC MP controller.  

Follow these steps to configure a global function button on the multi panel to shut down 
WinAC MP: 

1. Create or open a ProTool CS project with at least one screen. 

2. Select and double-click any screen in the project to open it. 

3. From the ProTool CS Screen Objects toolbar, click the Button toolbar button, then click in 
the fixed window at the top of the screen. (By placing the button in the fixed window, 
rather than the basic area, you are defining it as a global rather than a local object.) The 
button appears where you clicked and the Button dialog opens. 

4. From the General tab of the Button dialog, replace the ? in the Text box with the words 
“Shut down WinAC MP”. 

5. Click the Functions tab. The Select Object dialog opens above the Button dialog. If the 
Select Object dialog does not open automatically, select the “Show Functions Available 
for Selection” checkbox. 

6. From the Select Object dialog, navigate to the WinAC MP function group, and click 
Control_WinAC_MP. 

7. Click the <<Add button. The Parameters-Control_WinAC_MP dialog opens. 

8. From the Parameters-Control_WinAC_MP dialog, select Shutdown_WinAC_MP for the 
winac parameter. 

9. Click OK  to close the Parameters-Control_WinAC_MP dialog. 

10. Close the Select Object dialog. 

11. From the Functions tab of the Button dialog, select OnClick() from the Selected Functions 
for Event list. (The number enclosed in the parentheses marks indicates how many 
functions have been configured for this event on this key.) 

12. Click the OK button to dismiss the Button dialog. 

Following successful configuration, all the screens in the ProTool project display the global button 
that you configured. 

After you finish your changes in ProTool CS, you must save, compile and download your project 
to the multi panel. After a successful download, you can use the global button that you configured 
to shut down the WinAC MP controller from any ProTool screen on the multi panel. 
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Example for All Units: Configuring an Output Field to Display the Average 
Cycle Time 
This example shows how to insert a field on a ProTool screen that displays a numeric value for 
the average cycle time of the WinAC MP controller. This example applies to both the keyboard 
and touch panel units. You use the WinAC MP function Update_Average_Cycle_Time to provide 
the numeric value to display on the ProTool screen. 

Assigning a Tag to an Output Field on a ProTool Screen 
To insert an output field on a ProTool screen and map it to the average cycle time of the 
WinAC MP controller, follow these steps: 

1. Create or open a ProTool CS project with at least one screen. 

2. Select and double-click any screen in the project to open it. 

3. Select the output field icon  from the screen objects toolbar or select Insert > Output 
Field from the menu, and place the output field object on your screen. The Output Field 
dialog opens. 

 
Figure:   Configuring an Output Field 

4. If a tag for the average cycle time value already exists, select it from the list of tags for 
the Value field and click the Edit Tag button . The Tag dialog opens.  

If a tag for the average cycle time value does not exist, click the New Tag button  to 
create a tag for the value that the output field will display. The Tag dialog opens. 
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5. For a new tag, enter a tag name in the Name field of the Tag dialog, for example, 
AvgCycle. 

Select <No Controller> from the list for the PLC field. The WinAC MP function supplies 
the average cycle time; you do not obtain this value from an address in the PLC. 

 
Figure:   Entering a New Tag 

6. Click OK on the Tag dialog and Output Field dialog. 

You now have an output field on your ProTool screen with a tag for the average cycle time 
assigned to it. Next, you must associate the Update_Average_Cycle_Time WinAC MP function 
with this tag and this screen. You use the Generate Screen and Clear Screen ProTool events to 
complete this configuration. 
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Configuring a Generate Screen Event  
For any of the Get and Update functions, you must map the function and the tag to a Generate 
Screen event for the screen.  

To configure the AvgCycle tag and Update_Average_Cycle_Time function for a Generate Screen 
event, follow these steps: 

1. Click anywhere in the background area of screen. Be sure you did not select a screen 
object. 

2. Select Edit > Properties for the screen and select the Functions tab. The screen 
properties dialog opens, and the Select Object dialog opens. If you do not see the Select 
Object dialog, select the “Show Functions Available for Selection” checkbox on the 
screen properties dialog.  

3. Select a Generate Screen event on the screen properties dialog if it is not already 
selected. 

4. Select the Update_Average_Cycle_Time function from the list of WinAC MP functions in 
the Select Object dialog and click the <<Add button to map it to the Generate Screen 
event. The Parameters dialog opens. 

5. In the Cycle_Time field of the Parameters dialog, select the tag name you entered for the 
average cycle time value from the list. 

By default, the Action field is set to Switch_On. If not, select the Action parameter and 
select Switch_On from the action list. 

6. Click OK on the Parameters dialog. 

7. Close the Select Object dialog, and click OK on the screen dialog. 

You now have a screen that displays the average cycle time for WinAC MP. 
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Configuring a Clear Screen Event  
For screens with functions mapped to generate screen events, you must unmap the functions 
when the screen is cleared (exited). You must configure a clear screen event that corresponds to 
each generate screen event.  

To configure the AvgCycle tag and Update_Average_Cycle_Time function for a Clear Screen 
event, follow these steps: 

1. Click anywhere in the background area of screen. Be sure you did not select a screen 
object. 

2. Select Edit > Properties for the screen and select the Functions tab. The screen 
properties dialog opens, and the Select Object dialog opens. If you do not see the Select 
Object dialog, select the “Show Functions Available for Selection” checkbox on the 
screen properties dialog.  

3. Select a Clear Screen event on the screen properties dialog. 

4. Select the Update_Average_Cycle_Time function from the list of WinAC MP functions on 
the Select Object dialog and click the <<Add button to map it to the Clear Screen event. 
The Parameters dialog opens.  

5. In the Cycle_Time field of the Parameters dialog, select the tag name you entered for the 
average cycle time value from the list.  

By default, the Action field is set to Switch_Off. If not, select the Action parameter and 
select Switch_Off from the action list. 

6. Click OK on the Parameters dialog. 

7. Close the Select Object dialog, and click OK on the screen dialog. 

Note 
For each Generate Screen event you configured, you must configure a corresponding 
Clear Screen event. 

After you finish your changes in ProTool CS, you must save, compile and download your 
configuration to the multi panel. After a successful download, WinAC MP displays the 
average cycle time in the field that you configured. 
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Reference 
Features of the WinAC MP Controller 
The WinAC MP controller has the following features: 

y Accumulators: 4 (ACCU 1 to ACCU 4) 

y Communications: PROFIBUS-DP master device 

y Work memory 

y Load memory (RAM) 

y Distributed I/O only, no local I/O: 

You can configure the size of both process-image I/O areas (I and Q memory areas) from 
0 to 8192 bytes. These memory areas can be accessed directly by the instructions in the 
user program. 

Using Load (L) and Transfer (T) instructions (for statement list) or the Assign Value 
(MOVE) instruction (for ladder logic) to the peripheral I/O (PI and PQ memory areas), you 
can access up to 16384 bytes of inputs and 16384 bytes of outputs. 

The WinAC MP controller communicates with the distributed I/O as a PROFIBUS-DP master 
device. As a master device, the WinAC MP controller can communicate with up to 32 slave 
devices (either S7-DP slaves or other DP slaves). 
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Technical Specifications 
The table below describes performance characteristics and technical specifications of the 
WinAC MP controller. 
 

Performance Characteristics and Technical Specifications of WinAC MP Controller 
WinAC MP Controller Description 
Work memory 3 Mbytes 
Load memory (RAM) 2 Mbytes 
Accumulators 4 (ACCU 1 to ACCU 4) 
Local data 16 K bytes per priority class 
Clock Real-time system clock, based on the hardware clock of the 

multi panel 
Digital and Analog I/O 16384 bytes total I/O, addressable over a range of 0 to 16383 

 
You can freely assign the I/O between digital and analog inputs 
and outputs. For example, you can assign all of 16384 bytes to 
the inputs or all of the 16384 bytes to the outputs. However, the 
total amount allocated to all of the inputs and outputs cannot 
exceed the maximum of 16384 bytes.  

Process image I/O 
(user configurable) 
y Inputs 
y Outputs 

Default 512 bytes (inputs) and 512 bytes (outputs); each 
configurable from 0 to 8192 bytes 
y I 0.0 to I 8191.7 
y Q0.0 to Q8191.7 

Memory bytes 
y Retentive range 

(configurable) 
y Preset as retentive 

2 Kbytes 
y MB0 to MB2047 

 
y 16 bytes (MB0 to MB15) 

Counters 
y Retentive range 

(configurable) 
y Preset as retentive 

512 
y C0 to C511 

 
y 8 (C0 to C7) 

Timers (only updated in 
OB1) 
y Retentive range 

(configurable) 
y Preset as retentive 

512 
 
y T0 to T511 

 
y None 

Clock memory 
Bits of the clock memory 
byte toggle at specific times 
and are accessible from the 
user program. 

8 bits of clock memory (1 byte) 
8 frequencies within 1 byte of M memory: address is 
configurable 
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Performance Characteristics and Technical Specifications of WinAC MP Controller, continued 

WinAC MP Controller Description 
Address ranges for logic 
blocks: 
y FB 
y FC 
y DB 
y Total number of 

blocks that can be 
downloaded to 
WinAC MP 

 
 
y FB0 to FB65535 
y FC0 to FC65535 
y DB1 to DB65535 (DB0 is reserved) 
y 2500 

Nesting depth 24 per OB, with 2 asynchronous OBs (OB121 and OB122) per 
priority class 

PROFIBUS-DP interface: 
y DP address range 

 
 

y Number of DP 
slaves supported 

y Baud rate 
y Baud rate search 

(as a DP slave) 
y Transfer memory 

(as a DP slave) 
y Maximum segment 

distance 

  
y Address range is 16384 for inputs and outputs (but total 

amount supported is 1024 bytes for inputs and 1024 
bytes for outputs) 

y 32 
 

y Up to 12 Mbps (*) 
y Not applicable 

 
y Not applicable 

 
y Dependent on the baud rate (see table below) 

(*) 9.6 Kbps, 19.2 Kbps, 45.45 (31.25) Kbps, 93.75 Kbps, 187.5 Kbps, 500 Kbps, 1.5 Mbps, 3 Mbps, 6 Mbps, 12 
Mbps 

 

As shown in the table below, each segment of the PROFIBUS-DP network is limited to a 
maximum distance (or cable length), which is determined by the baud rate of the communication. 
 

Maximum Segment Distance Dependent on Baud Rate 

Baud Rate Maximum Cable Length 
9.6, 19.2, 93.75 Kbps 1200 m (3936 ft.) with an isolated interface 
187.5 Kbps 1000 m (3280 ft.) with an isolated interface 
500 Kbps 400 m (1312 ft.) 
1.5 Mbps 200 m (656 ft.) 
3, 6, 12 Mbps 100 m (326 ft.) 
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Organization Blocks (OBs) Supported 
OBs are the interface between the operating system of WinAC MP and the control program. The 
table below lists the OBs which are supported. The WinAC MP controller executes OBs according 
to the priority class. 
 

Organization Blocks (OBs) Supported 

OB Description Priority Class 
OB1 Main program cycle 1 (lowest) 
OB10 Time-of-day interrupt 2 to 24 
OB20 Time-delay interrupt 2 to 24 
OB35, OB36 Cyclic interrupt 2 to 24 
OB40 Hardware interrupt 2 to 24 
OB55 Status alarm interrupt 2 to 24 
OB56 Update alarm interrupt 2 to 24 
OB57 Manufacturer-specific alarm interrupt 2 to 24 
OB80 Time error 26 
OB82 Diagnostic interrupt 24 to 26 (or 28) (*) 
OB83 Module remove/insert interrupt 24 to 26 (or 28) (*) 
OB85 Priority class error 24 to 26 (or 28) (*) 
OB86 Rack failure 24 to 26 (or 28) (*) 
OB100 Warm restart 27 
OB102 Cold restart 27 
OB121 Programming error Priority class of the OB where the 

error occurred 
OB122 I/O access error Priority class of the OB that was 

interrupted 
(*) Priority class 28 during STARTUP mode of The WinAC MP controller, user-configurable priority class (from 24 to 

26) in RUN mode. 
 

OBs for the Main Program Cycle, Cold Restart, and Warm Restart 
The table below shows OBs for the main program cycle and cold and warm restarts. The 
WinAC MP controller uses OB1 (main program cycle) for continuously executing the user 
program. On the transition from STOP mode to RUN mode (or RUN-P mode), the WinAC MP 
controller executes OB100 (warm restart) or OB102 (cold restart), based either on the hardware 
configuration for the WinAC MP controller or which restart option was selected from a dialog 
displayed by the CPU panel. After OB100 (or OB102) has been successfully executed, the 
WinAC MP controller executes OB1. 
 

OBs for the Main Program Cycle, Cold Restart, and Warm Restart 
Organization Block (OB) Start Event (in Hex) Priority 
Main program cycle OB1 1101, 1103, 1104 1 
Warm restart OB100 1381, 1382 27 
Cold restart OB102 1385, 1386 27 
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Interrupt OBs 
The WinAC MP controller provides a variety of OBs that interrupt the execution of OB1. The table 
below lists the different interrupt OBs that are supported by the WinAC MP controller. These 
interrupts occur according to the type and configuration of the OB. 

The priority class determines whether the WinAC MP controller suspends the execution of the 
user program (or other OB) and executes the interrupting OB. The priority class is configurable. 
 

Interrupt OBs 

Interrupts Start Event 
(in Hex) 

Default 
Priority 

Time-of-Day Interrupt OB10 1111 (OB10) 2   (Low) 
 

Time-Delay Interrupt 
Range: 1 ms to 60000 ms 

OB20 1121 (OB20) 3 

Cyclic Interrupt 
Range: 1 ms to 60000 ms 
Recommended: > 10 ms 

OB35 
OB36 

1136 
1137 

12 
13 

Hardware interrupt OB40 1141 (channel 1) 16   (High) 
Status alarm interrupt  OB55 2 to 24  
Update alarm interrupt  OB56 2 to 24  
Manufacturer-specific alarm 
interrupt  

OB57 2 to 24  

 

If the WinAC MP controller has been configured to execute a particular interrupt OB, but that OB 
has not been downloaded, the WinAC MP controller reacts in the following manner: 

y If OB10, OB20, OB40 , OB55, OB56, or OB57 is missing and OB85 has not been 
downloaded, the WinAC MP controller changes operating mode (from RUN to STOP). 

y WinLC remains in RUN mode if a cyclic interrupt OB (OB32 to OB36) is missing. If these 
OBs cannot be executed at the specified time and OB80 has not been downloaded, 
WinLC changes from RUN mode to STOP mode 

Note 
You can configure OB35 and OB36 to be executed as frequently as every 10 
milliseconds (ms). If you schedule an OB to be executed at a specific interval, make 
certain that the program can be executed within the time frame and also that your 
WinAC MP application can process the OB within the allotted time. 
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Error OBs 
As shown in the table below, the WinAC MP controller supports a variety of error OBs. Some of 
these error OBs have the configured (user-assigned) priority class, while others (OB121 and 
OB122) inherit the priority class of the block where the error occurred. 

The local variables for OB121 and OB122 contain the following information that can be used by 
the program to respond to the error: 

y The type of block (byte 4) and the number (bytes 8 and 9) where the error occurred 

y The address within the block (bytes 10 and 11) where the error occurred 

If the start event occurs for a particular error OB that has not been downloaded, the WinAC MP 
controller changes operating mode from RUN to STOP. 
 

Error OBs 

Error  or  Fault OB Start Event (in Hex) Default Priority 
Time-out error OB80 3501, 3502, 3505, 3507 26 
Diagnostic Interrupt OB82 3842, 3942 26 
Insert/remove module interrupt OB83 3861, 3863, 3864, 3961, 

3865 
26 

Priority class error: 
y Start event occurs for an 

OB that has not been 
downloaded. 

y During the I/O cycle, the 
WinAC MP controller 
attempts to access a 
module or DP slave that is 
defective or not plugged in. 

y The WinAC MP controller 
attempts to access a block 
(such as a DB) that has 
not been downloaded or 
has been deleted. 

OB85  
35A1 
 
 
39B1, 39B2, 39B3/38B3, 
39B4/38B4 
 
 
 
35A3 

26 

Rack failure (distributed I/O): a 
node in the PROFIBUS-DP 
subnetwork has failed or been 
restored. 

OB86 38C4, 39C4, 38C5, 39C5, 
38C7, 38C8 

26 (or 28) 

Programming error 
(For example: the user program 
attempts to address a timer that 
does not exist.) 

OB121 2521, 2522, 2523, 2524, 
2525, 2526, 2527, 2528, 
2529, 2530, 2531, 2532, 
2533, 2534, 2535, 253A; 
253C, 253E 

Same priority class 
as the OB in which 
the error occurred 

I/O access error 
(For example: the user program 
attempts to access a module that 
is defective or is not plugged in.) 

OB122 2942, 2943 Same priority class 
as the OB in which 
the error occurred 
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System Functions (SFCs) Supported 

WinLC MP provides SFCs, which are system functions that perform various tasks. The control 
program calls the SFC and passes the required parameters; the SFC performs its task and 
returns the result.  

• WinLC MP allows a maximum of 5 instances of the asynchronous system function 
SFC51 (index B1, B3) to be running. 

• WinLC MP allows a maximum of 20 asynchronous SFCs from the following set to be 
running:  SFC11, SFC13, SFC55, SFC56, SFC57, SFC58, and SFC59. 

• WinLC MP allows a maximum of 32 asynchronous SFCs in any combination from the 
following set to be running: SFC82, SFC83, and SFC84. 

Note 
An asynchronous SFC is an SFC that has a "Busy" output parameter. 

SFCs That Can Cause the Scan Cycle to Vary 

The following SFCs can cause the scan cycle to vary ("jitter"): 

• SFC22 (CREAT_DB) 

• SFC23 (DEL_DB) 

• SFC52 (WR_USMG) 

Execution Times 
The following table lists the execution times for the SFCs that WinLC MP supports. Execution 
times for asynchronous SFCs refer to the time for the SFC call, not the time for the job to 
complete. 
System Functions (SFCs) Supported 

SFC Name Description Execution 
Time in 
microseconds

SFC0 SET_CLK Sets the system clock 44 
SFC1 READ_CLK Reads the system clock 16 
SFC2 SET_RTM Sets the run-time meter 9 
SFC3 CTRL_RTM Starts or stops the run-time meter 9 
SFC4 READ_RTM Reads the run-time meter 8 
SFC5 GADR_LGC Queries the logical address of a channel 16 
SFC6 RD_SINFO Reads the start information of an OB 15 
SFC11 DPSYNC_FR Synchronize groups of DP slaves 10 
SFC12 D_ACT_DP Deactivating and activating of DP slaves Not applicable 
SFC13 DPNRM_DG Reads the diagnostic data of a DP slave 

DP configuration tested: one ET 200M slave with 
one 8-input/8-output module and one 16-output 
module 

30 
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System Functions (SFCs) Supported 
SFC14 DPRD_DAT Reads the consistent data from a DP slave 22 
SFC15 DPWR_DAT Writes the consistent data to a DP slave 22 
SFC17 ALARM_SQ Generates an acknowledgeable block-related 

message 
43 

SFC18 ALARM_S Generates an unacknowledgeable block-related 
message 

52 

SFC19 ALARM_SC Queries the status for the last message (SFC17 or 
SFC18) 

15 

SFC20 BLKMOV Copies variables 21 
SFC21 FILL Initializes a memory area 1 word 

50 words 
100 words 

22 
24 
26 

SFC22 CREAT_DB Creates a data block 59 
SFC23 DEL_DB Deletes a data block 21 
SFC24 TEST_DB Provides information about a data block 10 
SFC26 UPDAT_PI Updates the process-image input table 

DP configuration tested: one ET 200M slave with 
one 8-input/8-output module and one 16-output 
module 

33 

SFC27 UPDAT_PO Updates the process-image output table 
DP configuration tested: one ET 200M slave with 
one 8-input/8-output module and one 16-output 
module 

33 

SFC28 SET_TINT Sets the time-of-day interrupt (OB10) 26 
SFC29 CAN_TINT Cancels the time-of-day interrupt (OB10) 13 
SFC30 ACT_TINT Activates the time-of-day interrupt (OB10) 9 
SFC31 QRY_TINT Queries the time-of-day interrupt (OB10) 11 
SFC32 SRT_DINT Starts the time-delay interrupt (OB20) 33 
SFC33 CAN_DINT Cancels the time-delay interrupt (OB20) 19 
SFC34 QRY_DINT Queries the time-delay interrupt (OB20) 18 
SFC36 MSK_FLT Masks synchronous errors 15 
SFC37 DMSK_FLT Unmasks synchronous errors 14 
SFC38 READ_ERR Reads the error register 14 
SFC39 DIS_IRT Disables the processing of all new interrupts 13 
SFC40 EN_IRT Enables the processing of new interrupts 14 
SFC41 DIS_AIRT Disables the processing of new interrupts with 

higher priority than the current OB 
9 

SFC42 EN_AIRT Enables the processing of new interrupts with 
higher priority than the current OB 

18 

SFC43 RE_TRIGR Retriggers the watchdog timer (monitoring the 
cycle time) 

68 

SFC44 REPL_VAL Transfers a value to ACCU1 (accumulator 1 ) 45 
SFC46 STP Changes the operating mode to STOP Not applicable 
SFC47 WAIT Delays the execution of the user program 1000 
SFC49 LGC_GADR Queries the module slot belonging to a logical 

address 
13 

SFC50 RD_LGADR Queries all of the logical addresses of a module 28 
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System Functions (SFCs) Supported, continued 

SFC Name Description Execution 
Time in 
microseconds

SFC51 RDSYSST Reads all or part of a system status list 40 
SFC52 WR_UMSG Writes a user element to the diagnostics buffer 58 
SFC54 RD_PARM Reads the defined parameter 29 
SFC55 WR_PARM Writes the defined parameter 43 
SFC56 WR_DPARM Writes the default parameter 32 
SFC57 PARM_MOD Assigns the parameters to a module 30 
SFC58 WR_REC Writes a data record 44 
SFC59 RD_REC Reads a data record 43 
SFC62 CONTROL Checks status of an SFB instance Not applicable 
SFC64 TIME_TCK Reads the time from the system clock 7 
SFC78 OB_RT Reports OB runtime information, with resolution to 

the nearest millisecond 
Not applicable 

SFC79 SET Sets a range of outputs 11 
SFC80 RESET Resets a range of outputs 11 
SFC82 CREA_DBL Creates a block in load memory Not applicable 
SFC83 READ_DBL Copies data from a block in load memory Not applicable 
SFC84 WRIT_DBL Writes to Load Memory blocks so data is saved 

immediately. Load memory blocks that are used to 
recover from an abnormal termination can be 
updated while the program is running. Use SFC84 
only for larger segments of a database, not for 
frequent variable processing. 

Not applicable 
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System Function Blocks (SFBs) Supported 
The WinAC MP controller provides SFBs, which are logic blocks similar to SFCs. When the user 
program calls an SFB, a data block (DB) must also be assigned. The table below lists the SFBs 
that WinAC MP supports: 
 

System Function Blocks (SFBs) Supported 
SFB Name Description Execution 

Time in 
microseconds

SFB0 CTU Provides a "count up" timer 15 
SFB1 CTD Provides a "count down" timer 15 
SFB2 CTUD Provides a "count up/down" timer 19 
SFB3 TP Generates a pulse 16 
SFB4 TON Generates an on-delay timer 16 
SFB5 TOF Generates an off-delay timer 16 
SFB8 USEND Sends a data packet of CPU-specific length (two-way)  
SFB9 URCV Receives a data packet of CPU-specific length (two-

way) 
 

SFB12 BSEND Sends a data block up to 64 Kbytes (two-way)  
SFB13 BRCV Receives a data block up to 64 Kbytes (two-way)  
SFB14 GET Reads data up to a CPU-specific maximum length 

(one-way) 
 

SFB15 PUT Writes data up to a PCU-specific maximum length 
(one-way) 

 

SFB22 STATUS Queries the status of a remote device  
SFB23 USTATUS Receives the status of a remote device  
SFB32 DRUM Implements a sequencer 48 
SFB52 RDREC Reads data set  
SFB53 WRREC Writes data set  
SFB54 RALRM Reads alarm data for a DP slave  

 

Other S7 Blocks Supported 
In addition to organization blocks (OBs), system functions (SFCs), and system function blocks 
(SFBs),  you can use these other S7 blocks in a control program for WinAC MP: 

y Function (FC): the address range for FCs supported by the WinAC MP controller is FC0 
to FC65535. Each FC can contain up to 65,570 bytes. 

y Function block (FB): the address range for FBs supported by the WinAC MP controller is 
FB0 to FB65535. Each FB can contain up to 65,570 bytes. 

y Data block (DB): the address range for DBs supported by the WinAC MP controller is 
DB1 to DB65535. (DB0 is reserved.) Each DB can contain up to 65,534 bytes. 

 Notice 
Although the address ranges higher than 2500 are supported, the WinAC MP controller 
supports a maximum of 2500 blocks. (In other words, the total number of FBs, FCs, DBs, 
OBs, and SDBs, together, cannot exceed 2500.) 

 

For more information about OBs, SFCs, and SFBs, see the System Software for S7-300 and 
S7-400 System and Standard Functions Reference Manual.  
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Execution Times of Instructions 
The execution times listed in the tables below, Execution Times of Math Operations and 
Execution Times of Instructions, reflect the average execution times for STEP 7 programs 
running on the WinAC MP controller. Actual execution times may vary, depending on your 
system. 

For the performance test, the WinAC MP controller executed a test program with 3000 Boolean 
operations, reading and writing data to I/O modules over a PROFIBUS-DP network consisting of 
three ET200M nodes. In addition, the WinAC MP controller performed calculations to determine 
the distribution of performance data. 
 

Execution Times of Math Operations (in microseconds) 
Math Operation Integer Real Double Word 
Addition (+) 0.07 0.10 0.07 
Subtraction (-) 0.07 0.10 0.07 
Multiplication (*) 0.08 0.12 0.17 
Division (/) 0.21 0.18 0.17 
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Execution Times of Instructions (in microseconds) 
Execution Time 

 in microseconds 
Instructions 

Direct 
addressing 

Indirect 
addressing 

I 0.19 0.27 
M 0.19 0.43 
L 0.29 0.44 

DB 0.27 0.41 
T  0.53 0.72 

Boolean operations: Memory 
areas: 
A, AN O, ON, X, XN 

C 0.17 0.38 
Boolean operations (on the 
accumulator): 

==I, <>I, >I, <I, >=I, <=I 

 
 
0.17 

 
 
0.17 

Operations on the bits of the status 
word: 

A==0, A<>0, A>0, A<0, A>=0, A<=0 

 
 
0.17 

 
 
0.17 

Transitional contacts: 
y Edge Positive FP 
y Edge Negative FN 

  
0.32 
0.32 

  
0.32 
0.32 

Set/Reset operations 
(bit operands) 

Set S 
Reset R 

  
  
0.26 
0.24 

  
  
0.42 
0.42 

RLO Operations 
Negate RLO NOT 

Set RLO SET 
Clear RLO CLR 

Save RLO SAVE 

  
0.16 
0.14 
0.14 
0.16 

 
0.16 
0.14 
0.14 
0.16 

Operations on Timers 
Pulse timer SP 
Reset (timer) R 

Extended pulse timer SE 
On-delay timer SD 

Retentive on-delay timer SS 
Off-delay timer SF 

 
0.59 
0.18 
0.59 
0.59 
0.60 
0.62 

 
0.79 
0.39 
0.79 
0.79 
0.81 
0.82 

Miscellaneous: 
Open DB OPN 

Load L 
Transfer T 

 
0.51 
0.17 
0.17 

 
0.51 
0.17 
0.17 
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System Status List (SSL) 
STEP 7 stores read-only information about the controller in the system status list (SSL) as a set 
of sublists.  

You use SFC51 (RDSYSST) to access the entries in the system status list. You supply the input 
parameters SSL_ID and Index to access the records stored in the sublist. SFC51 returns a two-
word header and a sublist or partial sublist. The header provides the following information about 
the sublist:  

y The first word defines the length (size in bytes) of a record for the sublist.  

y The second word defines the number of records contained in the sublist.  

The sublist that follows contains all of the information requested. The size of the sublist in bytes is 
the record length times the number of records.  

For more information about the system status list, see the System Software for S7-300 and S7-
400 System and Standard Functions Reference Manual.  

The table below provides an overview of the SSL sublists, sorted according to the SSL-ID. You 
use the SSL-ID and index (as hexadecimal numbers: 16#) to access the records stored in the 
sublist.  

SSL_ID (hex) Sublist Index (hex) Record Contents 

 SSL ID   

0000 All available SSL-IDs Examples: Information on all available SSL 
IDs 

0100 Sublist with all sublist excerpts 00xy List of SSL IDs supported by 
WinLC in group 00xy (Example: 
0024, CPU Operating Status) 

0200 A sublist excerpt 0xyz SSL ID 0xyz if supported by 
WinLC, 0 if not 

0300 All available indices for an SSL_ID 0xyz List of indices corresponding to 
SSL ID 0xyz 

0F00 Header information only  Number of all SSL IDs of the 
module 

 CPU identification  WinLC type and version number 

0011 All records of the sublist   

0111 One record of the sublist 0001 Identification of the module 

  0007 Identification of the firmware 

0F11 Header information only   
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SSL_ID (hex) Sublist Index (hex) Record Contents 

 CPU characteristics   

0012 All characteristics   

0112 One group of characteristics 0000 MC7 processing unit 

  0100 Time system in WinLC 

  0200 System response 

  0300 Language description of WinLC 

0F12 Header information only   

 Memory areas   

0013 All memory areas   

0113 One memory area 0001 User memory 

  0002 Load memory integrated 

  0003 Load memory inserted 

  0004 Maximum insertable load 
memory 

  0005 Size of backup memory 

  0006 Size of PBC memory assigned 
on the system-side (shadow 
memory) 

0F13 Header information only   

 Operating system areas   

0014 All system areas of a module   

0114 One system area 0001 Process-image input area (bytes) 

  0002 Process-image output area 
(bytes) 

  0003 Memory (bits) 

  0004 Number of timers 

  0005 Number of counters 

  0006 I/O address area (bytes) 

  0007 Total local data area of CPU 
(bytes) 

0F14 Header information only   
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SSL_ID (hex) Sublist Index (hex) Record Contents 

 Block types   

0015 All block types of a module   

0115 One block type 0800 OBs (number and size) 

  0A00 DBs (number and size) 

  0B00 SDBs (number and size) 

  0C00 FCs (number and size) 

  0E00 FBs (number and size) 

0F15 Header information only   

 Status of the module LEDs    

0019 All LEDs   

0119 One LED 0002 INTF Internal failure 

  0003 EXTF External failure 

  0004 RUN Run 

  0005 STOP Stop 

  0006 FRCE Force 

  0007 CRST Complete restart 

  000B BUSF1 Bus fault 

  000C BUSF2 Bus fault 

  0011 BAF Battery failure 

  0012 BUSF3 Bus fault 

  0013 BUSF4 Bus fault 

0F19 Header information only   

 Interrupt/error assignment  Not applicable Not applicable 

0021 All possible interrupts   

0A21 All assigned interrupts   

0F21 Header information only   

 Interrupt status   

0222 One specific interrupt 0001 Event that started OB1 

  0050 Event that started OB80 
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SSL_ID (hex) Sublist Index (hex) Record Contents 

 Priority class   

0023 All priority classes  Priority of possible OBs 

0123 One specific priority class Priority class  

0223 All configured priority classes   

0F23 Header information only   

 Operating status of the CPU   

0124 Last executed operating status 
transition 

  

0424 Current operating status   

0524 Specified operating status 4520 Defective status 

  5000 STOP status 

  5010 Startup status 

  5020 RUN status 

  5030 HALT status 

0F24 Header information only   

 Communications performance    

0131 Parameters of the communications 
type specified 

0001 Number of connections and baud 
rates 

  0002 Test and startup parameters 

  0003 Operator interface parameters 

  0004 Object management system 
(operating system function) 

  0005 Diagnostics functions and 
diagnostics entries 

  0006 PBC performance parameters 

  0009 Number of run-time meters 

  0010 PMC event parameters 

0F31 Header information only   
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SSL_ID (hex) Sublist Index (hex) Record Contents 

 Communications status information   

0132 Parameters of the communications 
type specified 

0001 Number and type of connections 

  0002 Number of test jobs set up 

  0004 CPU protection level 

  0005 Diagnostics 

  0006 PBK status data 

  0008 Time system, correction factor, 
run-time meter, date and time of 
day 

  0009 Baud rate (set by means of the 
MPI) 

  000A Baud rate (set by means of the 
S7-300 backplane bus) 

  0010 PMC S7-SCAN Part 1 

0F32 Header information only   

 Diagnostic Station List not applicable not applicable 

0033 All entries    

0F33 Header information only   

 Start-up events   

0782 Start-up events of all OBs of a 
priority class before processing 

Priority class Event ID, priority class, and OB 
number 

 Module status information   

0A91 All DP subsystems and DP 
masters 

  

0C91 One module Logical base 
address 

  

Features and parameters of the 
module 

0D91 One station Rack, or DP 
master system 

ID, or DP master 
system ID and 
station number 

All the modules of a station in the 
PROFIBUS-DP network 

0F91 Header information only    
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SSL_ID (hex) Sublist Index (hex) Record Contents 

 Status information of the stations in 
a DP network 

 Status information for the 
stations connected to a 
PROFIBUS-DP network 

0092 Expected status of nodes in a DP 
master system 

0 / DP master 
system ID 

 

0192 Activation status of the stations of 
a DP master system ID 

  

0292 Actual status of the nodes in a 
subnetwork 

0 / DP master 
system ID 

 

0692 DP slaves indicating failure of one 
or more modules 

0 / DP master 
system ID 

 

0F92 Header information only   

 Expanded DP Master system 
information 

 Status information regarding 
synchronicity for the nodes 
connected to a PROFIBUS-DP 
network. 

0095 All DP master systems known to 
the CPU 

0 / DP master 
system ID |  
L-Byte=00H 

 

0195 One DP master system   

0F95 Header information only   

 Diagnostics buffer  Event information (dependent on 
the event) 

00A0 All entries (event information)   

01A0 Specified number of entries Number  

0FA0 Header information only   

 Module diagnostics  Module-dependent diagnostics 
information 

00B1 First four diagnostic bytes of one 
module (data record 0) 

Logical base 
address 

 

00B3 All diagnostic data of one module 
(data record 1) 

Logical base 
address 

 

00B4 Diagnostic data of a DP slave Configured 
diagnostic 
address 
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Performance Test: Scan Time "Jitter" 
Based on the hardware configuration of your multi panel, and also the CPU utilization by other 
software applications, the scan cycle for the WinAC MP controller can experience "jitter" (where 
the scan cycle varies from the configured minimum scan time). 

For the performance test, the WinAC MP controller executed a test program with 3000 Boolean 
operations, reading and writing data to I/O modules over a PROFIBUS-DP network consisting of 
three ET200M nodes. In addition, the WinAC MP controller performed calculations to determine 
the distribution of performance data. 
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Troubleshooting 
Use the table below to troubleshoot difficulties that you encounter. 
 

Troubleshooting 

Problem Possible Cause Corrective Action 
Nothing displays on 
the multi panel 
after installing the 
WinAC MP runtime 
files. 

Multi panel does not have a 
ProTool project with a user 
interface for the WinAC MP 
controller. 

Use ProTool CS to install the example ProTool 
project with WinAC MP screens, or a 
customized project, on the multi panel. 

The WinAC MP 
software did not 
transfer to the multi 
panel. 

Wrong cable used, wrong 
ports connected, or wrong 
parameters specified. 

Review the topic “Setting Parameters for 
Communications” (p.8) and correct any errors.

Parameter mismatch. Make sure you use the IP address of the multi 
panel in your connection parameters on the 
configuration computer. Review the topic 
“Setting Parameters for Communications” 
(p.8). 

Fast Acknowledge is set Open Setting the PG/PC Interface from 
STEP 7 and the Properties dialog for the 
Interface Parameter Assignment field. Verify 
that the checkbox for “Fast Acknowledge” is 
not selected. You cannot download from 
STEP 7 to the multi panel if Fast Acknowledge 
is selected. 

Ethernet 
communication has 
stopped working. 

Cabling problem Networked: Check that you connected the 
configuration computer to the multi panel using 
a hub and twisted-pair, category 5 cables.  
Direct Connection: Check that you used 
crossover, twisted-pair, Category 5 cables. 
(You can create a crossover cable with a 
length of Category 5 cable and an RJ-45 
connector for each end. Wire one end 
normally; at the other end, connect 1 to pin 3 
and 2 to pin 6.) 
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Troubleshooting 
MPI or PROFIBUS 
communication is 
not working 

Communication settings 
between STEP 7 and the 
multi panel are different. 
 
Possibly a hardware 
configuration download 
from the configuration 
computer changed an MPI 
setting on the multi panel to  
PROFIBUS. 

Configure the configuration computer and the 
multi panel to use the same communication 
setting: 
 
• On the configuration computer, set the 

PG/PC Interface Parameter assignment to 
either the MPI or PROFIBUS selection for 
your CP card. 

 
• On the multi panel, use the Transfer utility 

from the Control Panel to set the Transfer 
Settings for Channel 2 to MPI. Set the S7-
Transfer Settings  for the multi panel to 
either MPI or PROFIBUS. The S7-
Transfer Settings are accessible through 
the Advanced button on the Transfer 
Settings dialog. 

 
The controller 
doesn't really do 
anything after 
installing the 
WinAC MP runtime 
files and a ProTool 
project. 

The controller contains no 
control program. 

Use STEP 7 to develop and download a 
control program. Review the topic “Developing 
and Downloading a STEP 7 Program for 
WinAC MP” (p. 23). 

The WinAC MP 
controller is not 
communicating 
with the 
PROFIBUS-DP 
device network. 

Wrong network 
configuration. 

Review the topic “Configuring the SIMATIC PC 
Station and the PROFIBUS-DP Network” 
(p. 25) and correct any errors. 
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